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1 Introduction
1.1 About the User Manual

This user manual provides step-by-step instructions on how to install the
drivers and the software needed on a host system or configuration PC
running under a Windows® operating system to configure and diagnose
Hilscher comX and netJACK communication modules or to update the
firmware of the modules.

This manual describes the installation of:

o the cifX Device Driver

¢ the SYCON.net configuration software

¢ the netX Configuration Tool (configuration tool for slave devices only)
e the USB Drivers

for the operating systems:
e Windows XP

e Windows 7

e Windows 8

_) Note: Instructions for installation under Windows 7 are also applicable for
installation under Windows VISTA.

The drivers and the configuration software are provided on the
Communication Solutions DVD.

1.1.1 List of Revisions

Index |Date Chapter Revision

1 2013-10-16 all created

Table 1: List of Revisions
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1.1.2 Conventions in this Document

Notes, operation instructions and results of operation steps are marked as
follows:

Notes

Important: <important note>

Note:

<note>

N <note, where to find further information>

Operation Instructions

1. <instruction>

2. <instruction>

or

»  <instruction>

Results

D <result>

1.1.3 Reference on Driver and Software Versions

This user manual refers to the following driver and software versions:

Name Version File name Path on Communication Solution DVD

SYCON.net 1.360.x.X SYCONnet netX setup.exe Software\SYCON.net

netX Configuration |1.0510.x.x | netXConfigurationUtility | Software\Slave Configuration Tool

Tool _Setup.exe

cifX Device Driver | 1.2.x.X citX Device Driver Driver and Toolkit\Device Driver

Setup.exe (NXDRV-WIN)\Instal lation

USB drivers - setup.exe Driver and Toolkit\USB Driver

Table 2: Reference on Drivers and Software

Software Installation comX and netJACK | Installing Drivers and Configuration Software

DOC130405UMO1EN | Revision 1 | English | 2013-10 | Released | Public

© Hilscher 2013




Introduction 6/116

1.2 Legal Notes
1.2.1 Copyright

© Hilscher 2013, Hilscher Gesellschatft fur Systemautomation mbH
All rights reserved.

The images, photographs and texts in the accompanying material (user
manual, accompanying texts, documentation, etc.) are protected by
German and international copyright law as well as international trade and
protection provisions. You are not authorized to duplicate these in whole or
in part using technical or mechanical methods (printing, photocopying or
other methods), to manipulate or transfer using electronic systems without
prior written consent. You are not permitted to make changes to copyright
notices, markings, trademarks or ownership declarations. The included
diagrams do not take the patent situation into account. The company
names and product descriptions included in this document may be
trademarks or brands of the respective owners and may be trademarked or
patented. Any form of further use requires the explicit consent of the
respective rights owner.

1.2.2 Important Notes

The user manual, accompanying texts and the documentation were created
for the use of the products by qualified experts, however, errors cannot be
ruled out. For this reason, no guarantee can be made and neither juristic
responsibility for erroneous information nor any liability can be assumed.
Descriptions, accompanying texts and documentation included in the user
manual do not present a guarantee nor any information about proper use
as stipulated in the contract or a warranted feature. It cannot be ruled out
that the user manual, the accompanying texts and the documentation do
not correspond exactly to the described features, standards or other data of
the delivered product. No warranty or guarantee regarding the correctness
or accuracy of the information is assumed.

We reserve the right to change our products and their specification as well
as related user manuals, accompanying texts and documentation at all
times and without advance notice, without obligation to report the change.
Changes will be included in future manuals and do not constitute any
obligations. There is no entitlement to revisions of delivered documents.
The manual delivered with the product applies.

Hilscher Gesellschaft fir Systemautomation mbH is not liable under any
circumstances for direct, indirect, incidental or follow-on damage or loss of
earnings resulting from the use of the information contained in this
publication.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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1.2.3 Exclusion of Liability

The software was produced and tested with utmost care by Hilscher
Gesellschaft fur Systemautomation mbH and is made available as is. No
warranty can be assumed for the performance and flawlessness of the
software for all usage conditions and cases and for the results produced
when utilized by the user. Liability for any damages that may result from the
use of the hardware or software or related documents, is limited to cases of
intent or grossly negligent violation of significant contractual obligations.
Indemnity claims for the violation of significant contractual obligations are
limited to damages that are foreseeable and typical for this type of contract.

It is strictly prohibited to use the software in the following areas:
o for military purposes or in weapon systems;

o for the design, construction, maintenance or operation of nuclear facili-
ties;

e in air traffic control systems, air traffic or air traffic communication sys-
tems;

¢ in life support systems;

¢ in systems in which failures in the software could lead to personal injury
or injuries leading to death.

We inform you that the software was not developed for use in dangerous
environments requiring fail-proof control mechanisms. Use of the software
in such an environment occurs at your own risk. No liability is assumed for
damages or losses due to unauthorized use.

1.2.4 Warranty

Although the hardware and software was developed with utmost care and
tested intensively, Hilscher Gesellschaft fir Systemautomation mbH does
not guarantee its suitability for any purpose not confirmed in writing. It
cannot be guaranteed that the hardware and software will meet your
requirements, that the use of the software operates without interruption and
that the software is free of errors. No guarantee is made regarding
infringements, violations of patents, rights of ownership or the freedom from
interference by third parties. No additional guarantees or assurances are
made regarding marketability, freedom of defect of title, integration or
usability for certain purposes unless they are required in accordance with
the law and cannot be limited. Warranty claims are limited to the right to
claim rectification.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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1.2.5 Export Regulations

The delivered product (including the technical data) is subject to export or
import laws as well as the associated regulations of different counters, in
particular those of Germany and the USA. The software may not be
exported to countries where this is prohibited by the United States Export
Administration Act and its additional provisions. You are obligated to
comply with the regulations at your personal responsibility. We wish to
inform you that you may require permission from state authorities to export,
re-export or import the product.

1.2.6 Registered Trademarks

Windows® XP, Windows® Vista, Windows® 7 and Windows® 8 are
registered trademarks of Microsoft Corporation.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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2 cifX Device Driver
2.1 Overview

If the host system of your communication module runs under a Windows
operating system or if you want to connect your module via PCI Carrier
Board (comX) or via Evaluation Board (netJACK) to a Windows PC for
configuration, diagnosis or firmware download with SYCON.net or netX
Configuration Tool, you need to install the cifX Device Driver.

The cifX Device Driver is delivered on the Communication Solutions DVD.
You can start an installation program for the driver (the cifX Device Driver
Setup) in the menu of the start screen of the DVD. Instructions for this are
provided on the following pages. You can also start the installation program
by double-clicking the cifX Device Driver Setup.exe file in the Driver and
Toolkit\Device Driver (NXDRV-WIN)\Installation directory of
the Communication Solutions DVD.

The installation program contains all components needed for the installation
of the driver under Windows XP, Windows Vista, Windows 7 and
Windows 8. It detects whether the 32 bit or the 64 bit driver needs to be
installed.

Please note the following:

¢ You need administrator rights for installing or uninstalling the cifX Device
Driver on your operating system.

¢ Always use the installation program, if possible, to install the cifX Device
Driver, as described on the following pages.

o If an older version of the cifX Device Driver is installed on your system,
uninstall it first before you install the new version.

¢ Install the cifX Device Driver before you connect your communication
module to your host system or PC (“software first” principle).

o After installing the cifX Device Driver and connecting your
communication module, check in the Device Manager of Windows if the
driver has been correctly installed and if Windows recognizes the
connected communication module.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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2.2 Installing cifX Device Driver

2.2.1 Installing cifX Device Driver under Windows XP
2211 Installing cifX Device Driver by Installation Program

1. Start the cifX Device Driver installation program.

» Insert the Communication Solutions DVD into your local DVD-ROM
drive.

> The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide
Install BYCOM. net Configuration Software
Documentation
Cirivers, Software and Tools
Install ciftd/ netJACH Device Driver
Install USB Driver
Ciriver Toolkit for Developer
Install Blave Configuration Software
Auiliary Tools

£\ oo (Crink

R ] i - ] i Sele
S — sercos Bl

WARRAR EOMPETENCE iN

. COMMUMICATION

Figure 1: Start Screen Communication Solutions — Installing cifX Device Driver

> In the menu, select Drivers, Software and Tools > Install
cifX/netJACK Device Driver.

Note: Alternatively, you can also start the installation program by double-
clicking the cifX Device Driver Setup.exe file in the Driver and
Toolkit\Device Driver (NXDRV-WIN)\Installation folder on
the Communication Solutions DVD.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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> The cifX Device Driver Setup is started and the License Agreement
window opens:

i& cifX Device Driver (x86) 1.2.x.x Setup L||:|g|

Please read the cifX Device Driver (286) 1.2.x.3.
License Agreement

HILSCZHER SOFTWARE LICENSE
AGREEMENT

1=

This document is a legal Agreement
between you, the Ticense, and
Hilscher Gesellschaft for
swystemautomation mhbH,
("Hil=scher")., Please read this
Agreement carefully before wou
install the software. By
installing or otherwise using the
software, you accept the terms of
this agreement. If wou do not
agree to the terms of this
agreement, then do not install or
use the software, return 7t to Us

54

[¥]T accept the kerms in the License Agreement:

Back [ Install ] ’ Cancel

Figure 2: cifX Device Driver Setup — License Agreement

2. Start installation.

» Select | accept the terms in the license agreement.
» Click Install.

= The cifX Device Driver installation is started:

i cif)X Device Driver (x86)1.2.3.x Setup

Installing cif¥ Device Driver (x86) 1.2.x.%

(e
=2

Please wait while the Setup Wizard installs cif ¥ Device Driver {x86) 1.2.x.x,

Status:

Back, ek

Figure 3: Installing cifX Device Driver

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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R After installation, the Completed the cifX Device Driver Setup Wizard
window appears:

i& cifX Device Driver (x86) 1.2.x.x Setup

== Completed the cifX Device Driver (x86)
. 1.2 % Sebup Wizard

Click the Finish button ko exit the Setup Wizard,

If wou upgraded From a previous wersion, you may need to
restart your computer to finish the Installation,

Figure 4: cifX Device Driver — Installation Completed

> Click Finish.

_} Note: Under Windows XP, the driver installation process is not yet
finished after having executed the cifX Device Driver Setup Wizard.

The installation process has to be completed in the Found New
Hardware Wizard, which automatically opens when you reboot
Windows XP after having installed the communication module in your host
system, respectively after having connected the module to your PC via
PCI Carrier Board (comX) or via Evaluation Board (netJACK) to your
Windows PC for the first time.

3. Install communication module in host system/PC.

Important: When installing the hardware, observe all safety messages in
the user manual.

» Shut down Windows XP and disconnect your host system or PC from
the voltage supply.

» Install the communication module in your host system, respectively
connect the communication module to your PC according to the
instructions provided in the user manual.

\ See user manual

-" = comX — Communication Modules for Real-Time-Ethernet and Fieldbus,
DOC100903UMxXEN

or

* netJACK Communication Module — Installation, Operation and
Hardware Description, DOC110504UMxXEN

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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4. Complete the installation in the Found New Hardware Wizard.
» Restart your host system/PC.
» The Found New Hardware Wizard starts:

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard
WWindows will search for current and updated software by

looking on your carnputer, on the hardware installation CD, or on
the Windows Update Web site [with your permizzion].

Bead our privacy policy

Can windows connect to Windows Update to zearch for
software?

() Yes. this time only

() Yes, now and gvery time | connect a device

@

Click Mext to continue.

[ Mest » ][ Cancel ]

Figure 5: Found New Hardware Wizard — cifX Device Driver (1)

» Answer the question Can Windows connect to Windows Update...?,
by selecting the No, not this time option.

» Click Next.
2 The window with the installation options appears:

Found Mew Hardware Wizard

Thiz wizard helps pou install zoftware for:

netlaCk. 100 PCI/PCle Device

3:') If your hardware came with an installation CD
2 or floppy disk. insert it now.

What do you want the wizard to do”?

(&) nstall the software automatically (Recommended}

() Install from a list o specific location [4Advanced)

Click Mext to continue.

[ ¢ Back “ Mest » ][ Cancel ]

Figure 6: Found New Hardware Wizard — cifX Device Driver (2)

» If you have already executed the installation program for the cifX Device
Driver (as recommended), you can ignore the wizard’s request to insert
a CD or floppy disk. Answer the What do you want the wizard to do?
guestion by selecting the Install the software automatically option.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO1EN | Revision 1 | English | 2013-10 | Released | Public © Hilscher 2013
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> Click Next.

2 Windows copies the driver files to the Windows directories.

Found New Hardware Wizard
Please wait while the wizard installs the software__. .

E‘;‘ﬁﬁ netACK, 100 PCI/PCle Device

WwidfColnstallerd 0094l
To E:NWINDODWS\system32

Figure 7: Found New Hardware Wizard — cifX Device Driver (3)

> The Completing the Found New Hardware Wizard window appears:

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished instaling the software for:

netlACK 100 PCI/PCle Device

Click Finizh to cloge the wizard.

Figure 8: Found New Hardware Wizard — cifX Device Driver (4)

» Click Finish.

> The installation of the cifX Device Driver is now complete.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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Checking Installation

After having installed the cifX Device Driver and having installed/connected
the communication module, you should check in the Windows Device
Manager if the driver has been correctly installed and if Windows

recognizes the communication module.

1. Open the Device Manager.

> In the Start menu of Windows, select Control Panel.

® The Control Panel opens:

B Control Panel

Fle Edit  Wiew

\_) Back -\_)

Favorites  Tools  Help

Lﬁ pSearch H__ Falders v

Address [} Contral Panel

J— Mame =~
ﬂ"" Control Panel = anternet Options
#mKeyhoard
[.} Switch bo Categaory Wiew ';_'] Miouse
ﬂ_-, Metwiark Connections
LPhone and Madern Options
See Also %Power Cptions

2 Printers and Faxes

Q Reqgional and Language Options

I3Scanners and Cameras

[ Scheduled Tasks

@ Security Center

Osoundmax sudiaese

'D», Sounds and Audio Devices

4 speech
Syskem

aTaskbar and Skart Menu

ﬂUser Accounts

a Windows CardSpace

el ‘Windows Firewall

=5 Wireless Mebwork Setup Wizard

% Windows Update
(7] Help and Support

V|GD
A

Camments
Configure your Internet displa. ..
Customize vour kevboard setti,..
Customize your mouse setking. ..
Connects ko other computers, ...
Configure your telephione diali. ..
Configure energy-saving setki...
Shows installed printers and Fa...
Customize settings for the disp. ..
&dd, remove, and configure sc...
Schedule computer tasks to ru...
View wour current secarity skat,..
Soundra AudicESP settings
Change the sound scheme For ...
Change settings for text-to-sp...
See information about your co...
Customize the Start Menu and ...
Change user account settings ...
Yerwalben Sie die zum Anmelde. ..
Configure the Windows Firewall
Set up or add to a wireless net...

W

Figure 9: Control Panel

» Inthe Control Panel, double-click System.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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> The System Properties sheet opens:

System Properties

Syztem Restore Automatic Updates Remote
General Computer Hame Advanced

Device Manager

The Device Manager lists all the hardware devices installed
= oh yaur computer. Use the Device Manager ta change the
properties of any device.

Levice Manager

Drivers

Diivver Signing lets you make sure that installed drivers are
compatible with Wwindows. Windows Update lets you set up
how Windows connects bo Windows Update for drivers.

’ Diriver Signing ] [ Windows Update

Hardware Profiles

Hardware profiles provide a way for pou to et up and store
different hardware configurations.

’ Hardware Profiles ]

[ Ok, H Cancel ]

Figure 10: System Properties

>
>

In the System Properties sheet, select Hardware tab.

In the Hardware tab, click Device Manager.

2 The Device Manager starts:

L Device Managen,

File Action Wiew Help
g 2 =
= = IMO1EN

—-E& cif¥ Communication Interface
0Nt JACK 100 PCI/PCle Device
+ -j Compuker

g Disk drives

g Display adapters

i DVDCD-RCM drives

=) Floppy disk controllers

j;, Floppey disk drives

{38 Humnan Interface Devices

=% IDE ATA/ATAPI controllers

“z» Kevboards

" Mice and other pointing devices
@ Monitors

E& Metwork adapters

5 Ports (COM & LPT)

ﬂ. Processaors

), sound, video and game controllers

System devices
Universal Serial Bus controllers

Figure 11: Display of Communication Module in Device Manager

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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2. Check if the communication module is recognized.

» In the Device Manager, click on the plus symbol in front of the
cifX Communication Interface entry.

2 A netJACK NJ 100EN-RE communication module for instance, which is
connected via NJEB-E Evaluation Board to the PCI Express interface of
the PC, will be displayed as netJACK 100 PCI/PCle Device.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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2.2.2 Installing cifX Device Driver under Windows 7
2221 Installing cifX Device Driver by Installation Program

1. Start the cifX Device Driver installation program.

» Insert the Communication Solutions DVD into your local DVD-ROM
drive.

 The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide
Install SYCOK. net Configuration Softhware
Documentation
Cirivers, Software and Tools
Install ciftd f netdACHK Device Driver
Install LISB Driver
Ciriver Toolkit for Developer
Install Slave Configuration Software
Auziliary Tools

A CANGOG: CC'HH K compoker>> Doviconer>> EherCAT™ pporipS> ’;

—
e — " . =5y S elet
T Moo R0 sercos [ il

. COMMUNICATION

Figure 12: Start Screen Communication Solutions — Installing cifX Device Driver

> In the menu, select Drivers, Software and Tools > Install
cifX/netJACK Device Driver.

Note: Alternatively, you can also start the installation program by double-
clicking the cifX Device Driver Setup.exe file in the Driver and
Toolkit\Device Driver (NXDRV-WIN)\Installation folder on
the Communication Solutions DVD.

You can reduce the number of Windows security questions by right-

clicking on the cifX Device Driver Setup.exe file and choosing Run as
administrator from the context menu.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
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> The cifX Device Driver Setup is started and the License Agreement
window opens:

-
ifX Device Dri 64) 1.2..x Set a ==t
ﬁ ci evice Driver (x64) x.H Setup —

Please read the cifX Device Driver (x64) 1.2.X.X
License Agreement

HILSCHER S0FTWARE LICENSE -
AGREEMENT I:I

This document is a legal Agreement
between you, the license, and
Hilscher Gesellschaft fur
Systemautomatﬁon mbH,
("Hilscher"). Please read this
agreement carefully before you
install the software. By
installing or otherwise using the
software, you accept the terms of
this agreement. If you do not
agree to the terms of this
agreement, then do not install or
use thelsof;warg: return it o us -

[¥]1 accept the terms in the License Agreement:

Back ’ @]_.nsmll ] [ Cancel

— ——- —

Figure 13: cifX Device Driver Setup — License Agreement

2. Start installation.

» Select | accept the terms in the license agreement.
» Click Install.

2 The cifX Device Driver is started:

fop ciff Device Driver (x64) 1.2.3.x Setu

TZAR
Installing cifX Device Driver (x64) 1.2.%.x

Please wait while the Setup Wizard installs cif¥ Device Driver (x64) 1.2.x.x.

Status:

Figure 14: Installing cifX Device Driver
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_>

@

R After installation, the Completed the cifX Device Driver Setup Wizard
window appears:

F eomneome o e =

Completed the cifX Device Driver (x64)
1.2.x.x Setup Wizard

Click the Finish button to exit the Setup Wizard.

If you upgraded from a previous version, you may need to
restart your computer to finish the Installation.

Figure 15: cifX Device Driver — Installation Completed

> Click Finish.

2 You can now proceed to connect your communication module to the
host system/PC.

Note: Under Windows 7, the driver installation process is practically
finished after having executed the installation program.

When you reboot Windows 7 after having installed the communication
module hardware in your host system, respectively after having connected
the module to your PC via PCI Carrier Board (comX) or via Evaluation
Board (netJACK) for the first time, the Installing device driver software
message appears in the Windows task bar. Windows then copies the
driver files to the appropriate Windows directories. This is an automated
process, you do not need to take any action in this. Finally, the Device
driver software installed successfully message appears in the task bar.

3. Install communication module in host system/PC.

Important: When installing the hardware, observe all safety messages in
the user manual.

» Shut down Windows 7 and disconnect your host system or PC from the
voltage supply.

» Install the communication module in your host system, respectively
connect the communication module to your PC according to the
instructions provided in the user manual.

\  See user manual
-" » comX — Communication Modules for Real-Time-Ethernet and Fieldbus,

DOC100903UMxXEN, respectively

= netJACK Communication Module — Installation, Operation and
Hardware Description, DOC110504UMxXEN
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Checking Installation

After having installed the cifX Device Driver and having installed/connected
the communication module, you should check in the Windows Device
Manager if the driver has been correctly installed and if Windows
recognizes the communication module.

1. Open the Device Manager.

> In the Start menu of Windows, select Control Panel.

® The Control Panel opens:

G@v@ v Control Panel »

Adjust your computer's settings

System and Security
Review your computer's status
Back up your computer

Find and fix preblems

Network and Internet
View network status and tasks
Cheose homegroup and sharing

opticns
, / Hardware and Sound
%‘ View devices and printers
Add a device
pE—% Programs
4 Uninstall a pregram
Fl

Get pregrams

© ¢ &K

- | 4 | | |Ss:f:-" Control Panel 0 |

View by: Category =

User Accounts
'5' Change account type

Appearance and
Personalization
Change the theme

Change desktop background
Adjust screen resclution

Clock, Language, and Region
Change keyboards or ether input
methods

Change display language

Ease of Access
Let Windows suggest settings
Optimize visual display

Figure 16: Adjust Your Computer’s Settings Window

» In the Control Panel, click Hardware and Sound.
® The Hardware and Sound window opens:

@legﬁ b Control Panel » Hardware and Sound »

Control Panel Home

i)

4

System and Security sEladTEE

Metwork and Internet
¢ Hardware and Sound

AutoPlay

Programs

User Accounts Sound

Appearance and
Personalization

Clock, Language, and Regicn

Ease of Access

Display

]

Devices and Printers
Add a printer

Change default settings for media or devices
Play CDs or other media automatically

Adjust system volume

Power Options
Change power-zaving settings
Require a password when the computer wakes
Change when the computer sleeps

Make text and other items larger or smaller
Connect to an external display

- | +y | | Search Control Panel

Change system sounds

Mouse '{“;'Devicel‘\ﬂanager

Manage audic devices

Change what the power buttons do

Choose a power plan

Adjust screen resolution
How to correct monitor flicker (refresh rate)
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Figure 17: Hardware and Sound Window

» In the Devices and Printers group of the Hardware and Sound
window, click Device Manager.

> The Device Manager starts:

=1 Device Manager EI@

File Action View Help
e | T EH HE B %S

4 = im0lwin7

Al_-'Il' cif Communication Interface
: (¥ netACK 100 PCI/PCle Device
.18 Computer

-y Disk drives
> M Display adapters
b ) DVD/CD-ROM drives
b =3 Floppy disk drives
b =3 Floppy drive controllers
5’;-3 Human Interface Devices
> g IDE ATA/ATAPI controllers
... Keyboards
b jz! Mice and other pointing devices
. | Monitors
l_-'I" MNetwork adapters
_‘@ Other devices
o X3 Perts (COM & LPT)
D Processors
b % Sound, video and game controllers
.---_'l." System devices
- ¢ Universal Serial Bus controllers

Figure 18: Display of Communication Module in Device Manager

2. Check if the communication module is recognized.

» In the Device Manager, click on the triangle in front of the
cifX Communication Interface entry.

2 A netJACK NJ 100EN-RE communication module for instance, which is
connected via NJEB-E Evaluation Board to the PCI Express interface of
the PC, will be displayed as netJACK 100 PCI/PCle Device.
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2.2.3 Installing cifX Device Driver under Windows 8
2.2.3.1 Installing cifX Device Driver by Installation Program

1. Start the cifX Device Driver installation program.

» Insert the Communication Solutions DVD into your local DVD-ROM
drive.

 The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide
Install SYCOK. net Configuration Softhware
Documentation
Cirivers, Software and Tools
Install ciftd f netdACHK Device Driver
Install LISB Driver
Ciriver Toolkit for Developer
Install Slave Configuration Software
Auziliary Tools

A CANGOG: CC'HH K compoker>> Doviconer>> EherCAT™ pporipS> ’;

—
e — " . =5y S elet
T Moo R0 sercos [ il

. COMMUNICATION

Figure 19: Start Screen Communication Solutions — Installing cifX Device Driver

> In the menu, select Drivers, Software and Tools > Install
cifX/netJACK Device Driver.

Note: Alternatively, you can also start the installation program by double-
clicking the cifX Device Driver Setup.exe file in the Driver and
Toolkit\Device Driver (NXDRV-WIN)\Installation folder on
the Communication Solutions DVD.

You can reduce the number of Windows security questions by right-

clicking on the cifX Device Driver Setup.exe file and choosing Run as
administrator from the context menu.
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> The cifX Device Driver Setup is started and the License Agreement

window opens:

Please read the cifX Device Driver (x64) 1.2.1.0
License Agreement

HILSCHER SOFTWARE LICENSE
AGREEMENT

This document is a legal agreement
between you, the license, and
Hilscher Gesellschaft for
Systemautomat1on mbH,

'Hilscher™). Please read this
Agreement carefully before you
install the software. By
. [installing or otherwise using the
software, you accept the terms of
this agreement. If you do not
agree to the terms of this
agreement, then do not install or
use thelsoftwareﬁ return it to us

[W]T accept the terms in the License Agreement:

Install

Figure 20: cifX Device Driver Setup — License Agreement

2. Start installation.

» Select | accept the terms in the license agreement.

> Click Install.
R The cifX Device Driver installation is started:

Installing cifX Device Driver (x64) 1.2.1.0

Please wait while the Setup Wizard installs ¢if¥ Device Driver (x64) 1.2.1.0.

Figure 21: Installing cifX Device Driver
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R After installation, the Completed the cifX Device Driver Setup Wizard
window appears:

i3 cif¥ Device Driver (x64) 1.2.X.X-Setup = =

Completed the cifX Device Driver (x64)
1.2.1.0 Setup Wizard

Click the Finish button to exit the Setup Wizard.

If you upgraded from a previous version, you may need to
restart your computer to finish the Installation.

Figure 22: cifX Device Driver — Installation Completed

» Click Finish.

2 You can now proceed to connect your communication module to the
host system/PC.

_} Note: Under Windows 8, the driver installation process is practically
finished after having executed the installation program.

When you reboot Windows 8 after having installed the communication
module hardware in your host system, respectively after having connected
the module to your PC via PCI Carrier Board (comX) or via Evaluation
Board (netJACK) for the first time, Windows copies the driver files to the
appropriate Windows directories. This is an automated process, you do
not need to take any action in this.

3. Install communication module in host system/PC.

Important: When installing the hardware, observe all safety messages in
the user manual.

» Shut down Windows 8 and disconnect your host system or PC from the
voltage supply.

» Install the communication module in your host system, respectively
connect the communication module to your PC according to the
instructions provided in the user manual.

~ See user manual
-" = comX — Communication Modules for Real-Time-Ethernet and Fieldbus,
DOC100903UMxXEN, respectively

* netJACK Communication Module — Installation, Operation and
Hardware Description, DOC110504UMxxXEN
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Checking Installation

After having installed the cifX Device Driver and having installed/connected
the communication module, you should check in the Windows Device
Manager if the driver has been correctly installed and if Windows

recognizes the communication module.
1. Open the Control Panel.

» In the Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 23: All Apps Button

» Click All apps.

2 A list featuring all available programs (Apps) appears:

Neues Office- it Sound Recorder
= | Dokument
E MNews 7-Zip File Manager — Steps Recorder
-Dokument 7-Zip Help 7 Ai Sticky Motes
‘I*l"(_ll"_’

Photos E f | Notepad++ Windows Journal
Windows Media

SkyDrive =) Cl 0 Calculator | | WordPad

Sparts b i ffice Character Map

Store [ i ft Offi Math Input Panel

MNotepad L Magnifier

Video . | Mico: e Paint Marrator

Connection

Snipping Tool

Figure 24: List of Installed Apps in Windows 8

» Inthe Apps list, click Control Panel.

En Command Prompt

Computer

Control Panel

Default Programs.

File Explorer

Help and Support

Run

[ask Manager

Defender
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2 Windows 8 changes into “desktop mode” and opens the Control Panel:

4+ [ v Control Panel »

Adjust your computer’s settings

System and Security

Review your computer's status

Save backup copies of your files with File
History

Find and fix problems

_ Network and Internet
i' View network status and tasks
3 Cheose homegroup and sharing options

Hardware and Sound
View devices and printers

|Search Control Panel

v &

Wiew by:  Category =

User Accounts
@ Change account type

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen resolution

Clock, Language, and Region
Add a language

Change input methods

Change date, time, or number formats

Add a device

Ease of Access
Let Windows suggest settings
Optimize visual display

Programs
Uninstall a pregram
Get programs

2,
N,
@

Figure 25: Control Panel

2. Open Device Manager.
» In the Control Panel, click Hardware and Sound.
2 The Hardware and Sound window opens:

@ - 4 % v Control Panel » Hardware and Sound » v O Search Control Panel

Control Panel Home c B
Devices and Printers

Add a device
Change Windows To Go startup eptions

-
Lo

Advanced printer setup | Mouse @ Device Manager

Systern and Security

Metwerk and Internet
Hardware and Sound

AutoPlay

Change default settings for media or devices | Play CDs or other media automatically

Programs
Sound
Adjust system volume

User Accounts
Change system sounds | Manage audic devices

Appearance and
Personalization

Power Options

Change power-saving settings
Require a password when the computer wakes
Choose a power plan

Clock, Language, and Region Change what the power buttons do

Ease of Access Change when the computer sleeps

Display
Make text and other items larger or smaller
How to correct monitor flicker (refresh rate)

;€ QO

Adjust screen reselution

Location Settings
Change lecation settings

Figure 26: Hardware and Sound
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» Inthe Devices and Printers group, click Device Manager.
> The Device Manager starts:

File Action View Help
e m| B Hm 8 E RS

a = im0lwind
> M Computer

[ — Disk drives

- B Display adapters

<2 DVD/CD-ROM drives

= Floppy disk drives

bE Floppy drive controllers

% Human Interface Devices

Cg IDEATASATAPI controllers

= Keyboards

B Mice and other pointing devices
| Monitors

[ El? MNetwork adapters

&+ i Other devices

& 15 Ports (COM & LPT)

[ @ Print queues

[ R Processors

[ I‘ij Sound, video and game controllers

[
[
[+
[+
[+
[
[
[+

4 El? cifX Communication Interface
[ net)ACK 100 PCI/PCle Device |

[ (M Systern devices
[ i Universal Serial Bus controllers

Figure 27: Display of Communication Module in Device Manager

3. Check if the communication module is recognized.

» In the Device Manager, click on the triangle in front of the
cifX Communication Interface entry.
2 A netJACK NJ 100EN-RE communication module for instance, which is

connected via NJEB-E Evaluation Board to the PCI Express interface of
the PC, will be displayed as netJACK 100 PCI/PCle Device.
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2.3 Uninstalling cifX Device Driver

2.3.1 Uninstalling cifX Device Driver under Windows XP

If you want to uninstall the USB drivers under Windows XP, proceed as

follows:

> In the Start menu of Windows XP, select Control Panel.

® The Control Panel opens:

B Control Panel

Fil=

\_) Back -\_)

Edit Wiew Faworites Tools  Help

Lﬁ pSearch H__ Falders v

Address [} Contral Panel

Mame =
Qp Accessibility Options
E ndd Hardware

ﬂ"' Control Panel S

[.} Switch bo Categaory Wiew

See Also

; e Programs

4@ Adrinistrative Tools

‘u Autarnatic Updates

!-! cif Setup

P ciF % Test

< Datke and Time

} Display

Flash Player

| Falder Options

ﬁ Fonts

& Game Controllers

‘ﬁlndexerstellung

Ed trtei(ry ama Driver
anternet Cpkions

@ Kevboard

) Mause

ﬂ_, Metwork Connections
LPhone and Madem Options
G

% Windows Update
(7] Help and Support

V|GD
A

Adjust wour computer settings ...
Installs and troubleshoots hat...
h Install or remove pragrams an...
Configure administrative settin...
Set up Wwindows ko autormatical. ..
Setup cif Boards and channels
Test your cify Boards and Cha. ..
Set the date, time, and time z...
Change the appearance of vo...
Manage Flash Plaver Settings
Customize the display of files a...
&dd, change, and manage fon...
&dd, remove, and configure g...
Microsoft Office Find Fast {tm). ..
Stewern Sie die Grafikhardwar..,
Configure your Internet displa. ..
Customize vour kevboard setti, ..
Customize your mouse setking...
Connects to other computers, ..
Configure your telephone diali, ..

Camments

W

Figure 28: Control Panel

» Inthe Control Panel, double-click Add or Remove Programs entry.
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? The Add or Remove Programs window opens:

% Add or Remove Programs

L5
Change ar
Remaove
Programs

%

Add New
Programs

AddiRemove

windaws
Components

@

Set Program
Access and
Defaults

Currently installed programs: [] show updates Sort by

1. cif% Device Driver (x86) 1.2.x.%

Ta remove this pragram Fram your computer, c

Size
Size
Size
Size

Entries from other programs

Size

Size

Size

Size
Size

Size

M e RS CRTY e

Size

205, 00ME

29.63MB

0.58MB

95.56MB

3.83ME

13, 8aMB

13.16MB

185.00MB

£, 30ME

169, 00ME

37.52MB

| €

Figure 29: Add or Remove Programs

» Select cifX Device Driver entry.
» Click Remove.
2> A security question appears:

Add or Remove Programs

\2'.') Are you sure you wank to remove cifs Device Driver (x86) 1.2.x,% from your computer?

[ tes |[ b ]

Figure 30: Acknowledge Uninstall

> Click Yes.

2 The cifX Device Driver is removed from your host system/PC.
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Uninstalling cifX Device Driver under Windows 7

For a complete removal of the cifX Device Driver under Windows 7, it is
recommended to delete the driver first in the Device Manager, and then to
uninstall the driver in the Uninstall or change a program window.

1. Open the Device Manager.

> In the Windows Start menu, select Control Panel.

® The Control Panel opens:

=N o ==

G@v@ + Control Panel »

Adjust your computer's settings

System and Security
Review your computer's status
Back up your cemputer

Find and fix problems

Network and Internet
View network status and tasks

Cheose homegroup and sharing
options

Hardware and Sound
View devices and printers

)

= | 3 | | |Search Control Panel fa) |

View by: Category ~

User Accounts
'5' Change account type

Appearance and
Personalization
Change the theme

Change desktop background
Adjust screen resclution

Clock, Language, and Region
Change keybeards or ether input

methods
Change display language

Add a device

Programs
Uninstall a pregram
Get pregrams

Ease of Access
Let Windows suggest settings
Optimize visual display

8,
A,

Figure 31: Adjust Your Computer’s Settings Window

> In the Control Panel, click Hardware and Sound.
= The Hardware and Sound window opens:

E=N EoR=<=

Programs
User Accounts

Appearance and
Personalization

Ease of Access

@legﬁ b Control Panel » Hardware and Sound »

Control Panel Home

System and Security
Metwork and Internet
¢ Hardware and Sound

Clock, Language, and Regicn

- | +y | | Search Control Panel

Devices and Printers

‘ .."
= g?I Add a device | Add a printer

Mouse
AutoPlay

Change default settings for media or devices
Play CDs or other media automatically

Sound

Adjust system volume | Change system sounds

Power Options
Change power-zaving settings
Require a password when the computer wakes

Change when the computer sleeps | Choose a power plan

Display
Make text and other items larger or smaller
Connect to an external display

'5' Device Manager

Manage audic devices

Change what the power buttons do

Adjust screen resolution
How to correct monitor flicker (refresh rate)

)

Figure 32: Hardware and Sound Window

» Inthe Devices and Printers group, click Device Manager.
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2 The Device Manager starts.

=y Device Manager
File Action View Help

& || E HE | B

1)

E=NEo =3

4 = im0lwind
A--E" cif Communication Interface
P {EF net]ACK 100 PCL/PCle Device

1M Computer
:r g Disk drives

- B Display adapters

> ¢4 DVD/CD-ROM drives

b =4 Floppy disk drives

+ =3 Floppy drive controllers
b 55 Hurnan Interface Devices

Update Driver Software...
Disable
Uninstall

Scan for hardware changes

Properties

b g IDE ATAJATAPI controllers

. Keyboards

b ﬂ Mice and other pointing devices
> B Monitors

b -EF Metwork adapters

» - |17 Other devices

o X Perts (COM & LPT)

b 2 Processors

b -& Sound, video and game controllers
b M Systemn devices

- ¢ Universal Serial Bus controllers

Scan for changed or new Plug ant

Figure 33: Display of Communication Module in Device Manager

2. Delete cifX Device Driver in the Device Manager.

» In the Device Manager, below the cifX Communication Interface
entry, right-click on the communication module (in this case it is
displayed as netJACK 100 PCI/PCle Device) and choose Properties

from the context menu.

2 The Properties sheet opens.

netlACK 100 PCI/PCle Device Properties

General |Dri\rer I Details I Resources

L- g netJACK 100 PCL/PCle Device
=

Manufacturer: Hilscher GmbH

Device status

Device type: cif ¥ Communication Interface

Location: PCl bus 2, device 0, function 0

[This device is working propery.

oK || Ccancel |

Figure 34: Properties of Communication Module in Device Manager
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» Choose Driver tab.
> The Driver tab opens.

netlACK 100 PCI/PCle Device Properties

| General | Driver | Details I

Resources

Driver Provider:
Driver Date:
Driver Version:

Digital Signer:

Driver Details

Update Driver...

Boll Back Driver

Disable

Uninstall

L- ¥ netJACK 100 PCI/PCle Device
=

Hilscher GmbH
22/02/2013

12XX

Hilscher Gesellschaft fuer Systemautomation
mbH

To view details about the driver files.
To update the driver software for this device.

if the device fails after updating the driver, roll
back to the previously installed driver.

Disables the selected device.

To uninstall the driver (Advanced).

[ ok || Ccancsl

]

Figure 35: Driver of Communication Module in Device Manager

> Click Uninstall.

2 The Confirm Device Uninstall dialog opens:

Confirm Device Uninstall

:. netJACK 100 PCI/PCle Device
<2

Waming: You are about to uninstall this device from your system.

[l

[¥] Delete the driver software for this device |

[ ok || Ccancel

Figure 36: Delete Driver Software

» Select Delete the driver software for this device option.

» Click OK.

2> The cifX Device Driver is being deleted.
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3. Uninstall cifX Device Driver in the Uninstall or change a program
window.

» In the Start menu of Windows, select Control Panel.
> The Adjust your computer’s settings window opens:

-]
O@v|@ + Control Panel » - |¢?| |Search Control Pane! jel |
Adjust your computer's settings View by: Category ¥
g System and Security User Accounts
’5 Review your computer's status r &) Change account type
’ Back up your computer - g we
Find and fix problems Appea rance and
w,_ Network and Internet w Personalization
ul View network status and tasks Change the theme
&2, Choose homegroup and sharing options Change desktop background
Adjust screen resolution
, / Hardware and Sound & Clock L d Regi
%‘ View devices and printers 0ck, Language, an . egion
Add a device 1= Ch;:;gs keyboards or other input
/ methods
E—% Programs Change display language
Uninstall —
d b ngis r‘:::gmm # W Ease of Access
P2 I | Let Windows suggest settings
\—/ Optimize visual display
Figure 37: Adjust Your Computer’s Settings Window
» Inthe Programs group, click Uninstall a program.
> The Uninstall or change a program window opens:
[E=8) N~
@uv| « Prog.. » Programs and Feat... - | 4 | Search Programs and Features pel |

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click

) Turn Windows features on or Uninstall. Change, or Repair.
off
Install a pregram frem the Organize *  Uninstall  Repair =z - @
network -
Mame -
FE
E‘I
¢
cif¥ Device Driver (x64) 1.2 T o
= Uninstall F
& Repair
D, Entries from other programs
LE
et -

e

m | 3
E Hilscher Gesellschaft fuer Systemautomation mbH
Figure 38: Uninstall or Change a Program Window

» Right-click on the cifX Device Driver entry and choose Uninstall from
the context menu.
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2 A confirmation request appears:

Programs and Features

[] Inthe future, do not show me this dialeg box

l . Areyou sure you want to uninstall cifX Device Driver (x64) 1.2..x?

I

Yes J [ Mo

Figure 39: Confirmation Dialog

> Click Yes.

> The cifX Device Driver is being uninstalled from your host system or

PC.
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2.3.3 Uninstalling cifX Device Driver under Windows 8

For a complete removal of the cifX Device Driver under Windows 8, it is
recommended to delete the driver first in the Device Manager, and then to
uninstall the driver in the Uninstall or change a program window.

1. Open the Control Panel.
In the Start screen of Windows 8, right-click on an empty space.

>

2 The All apps button appears in the lower part of the screen:

All apps

Figure 40: All Apps Button

» Click All apps.

2 A list featuring all available programs (Apps) appears:

Apps

n Office-Dokument

= affnen

a People
Photos

Reader
SkyDrive
Sparts

Store

Video

7-Zip File Manager
7-Zip Help

‘I*!"(_II' L’

{  Notepad++

Calculator

Character Map

Math Input Panel

MNotepad

Paint

Figure 41: List of Installed Apps in Windows 8

>

In the Apps list, click Control Panel.

Sound Recorder

Sticky Motes
Window:
Scan

Windows Journal

Windows Media

i  WordPad

Magnifier

Marrator

En Command Prompt

Computer

Control Panel

Default Programs.

File Explorer

Help and Support

Run

g Task Manager

B ‘Windows Defender
o
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2 Windows 8 changes into “desktop mode” and opens the Control Panel:

1+ [ » Control Panel »

Adjust your computer’s settings

System and Security

Review your computer's status

Save backup copies of your files with File
History

Find and fix preblems

o,

&

Network and Internet
View netwerk status and tasks
Cheoose homegroup and sharing options

Hardware and Sound
View devices and printers
Add a device

Programs
Uninstall a pregram
Get programs

Figure 42: Control Panel

2. Open Device Manager.
>

|Search Control Panel

v &

View by: Category *

User Accounts
'@] Change account type

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen reselution

Clock, Language, and Region
Add a language

Change input metheods

Change date, time, or number formats

Ease of Access
Let Windows suggest settings
Qptimize visual display

In the Control Panel, click Hardware and Sound.

2 The Hardware and Sound window opens:

- 1 % » Control Panel » Hardware and Sound »

®

Search Control Panel

v G

Control Panel Home c .
Devices and Printers

Systemn and Security D i

Metweork and Internet

Advanced printer setup

Mouse @Devicel\-"lanager

Change Windows To Ge startup eptions

Hardware and Sound AUtDPIaY

Change default settings for media or devices

Programs
Sound
Adjust system volume

User Accounts

Appearance and
Personalization Power Options

Clock, Language, and Region Change power-saving settings

Ease of Access
Choose a power plan

Display
Make text and other items larger or smaller
How to correct monitor flicker (refresh rate)

Location Settings
Change location settings

Figure 43: Hardware and Sound

Change system sounds

Require a password when the computer wakes

Manage audio devices

Change what the power buttons do

Adjust screen reselution

Play CDs or other media autematically

Change when the computer sleeps
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>

In the Devices and Printers group, click Device Manager.

> The Device Manager starts.

File Action View Help

&= @ E HmE € @SS

Figure 44: Display of Communication Module in Device Manager

2. Delete cifX Device Driver in the Device Manager.

>

2 The Device Properties sheet opens:

Figure 45: Properties of Communication Module in Device Manager

a = im0Twind

4 W cifX Communication Interface

net)ACK 100 DrLDC e Naviea |

18 Computer Update Driver Software...

— Disk drives Disable

'5'1 Display adapters Uninstall
o5 DVD/CD-ROM d
<= Floppy disk drive Scan for hardware changes

£ Floppy drive con

Properties

g IDE ATA/ATAPI controllers
= Keyboards
ﬂ Mice and other pointing devices
& Monitors
El? Metwork adapters
3 Other devices
[t PCI Serial Port
i PCI Simple Cemmunications Controller
b Y5 Ports (COM &L LPT)
[ @ Print queues
I R Processors
[ ﬂ' Sound, video and game controllers

[=
[=
[
[
[+
[+
[ % Human Interfac
[
[
[+
[+
[=
4

[ M Systern devices
[ i Universal Serial Bus controllers

In the Device Manager, below the cifX Communication Interface
entry, right-click on the communication module (in this case it is
displayed as netJACK 100 PCI/PCle Device) and choose Properties

from the context menu.

General |D1'i\rer I Dietails I Events I Resources

‘b netJACK 100 PCL/PCle Device
e,

Device type: cif ¥ Communication Interface
Manufacturer: Hilscher GmbH
Location: PCl bus 2, device 0, function 0

Device status

This device ig working property.
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» Choose Driver tab.
> The Driver tab opens.

|Geneml| Driver | Details I Events I Resources

Eh netACK 100 PCI/PCle Device
=

Driver Provider: Hilscher GmbH
Driver Date: 272252013
Driver Version: 1210

Digital Signer: Hilscher Gesellschaft fuer Systemautomation
mbH

To view details about the driver files.

To update the driver software for this device.

- If the device fails after updating the driver, rol
ol back to the previously installzd driver.

Disables the selected device.
To uninstall the driver [Advanced).

OK || Cancel

Figure 46: Driver of Communication Module in Device Manager

» Click Uninstall.
2 The Confirm Device Uninstall dialog opens:

Ej netJACK 100 PCI/PCle Device
.

Waming: You are about to uninstall this device from your system.

[]iDelete the driver software for this device ;

Figure 47: Delete Driver Software

» Select Delete the driver software for this device option.
» Click OK.
2> The cifX Device Driver is being deleted.
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3. Uninstall cifX Device Driver in the Uninstall or change a Program
window.

» Open Control Panel.
> The Control Panel opens:

1 E » Control Panel » v &

|Search Control Panel

Adjust your computer’s settings

View by: Category *

System and Security

Review your computer's status

Save backup copies of your files with File
History

Find and fix problems

Network and Internet

| View network status and tasks

Choose homegroup and sharing options

Hardware and Sound
View devices and printers
Add a device

Programs

User Accounts
'@' Change account type

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen reseluticn

Change date, time, or number formats

Ease of Access

Let Windows suggest settings
Optimize visual display

Clock, Language, and Region
ol Add a language
LN Change input methods

Uninstall a program
Get programs

Figure 48: Control Panel

» In the Programs group of the Control Panel, click Uninstall a
program.

2 The Programs and Features window opens:

- 1 ﬂ« Programs » Programs and Features v O Search Programs and Features 0

Control Panel Home .
Uninstall or change a program

View installed updates Te uninstall a program, select it from the list and then click Uninstall, Change, or

Repair.

Organize = Repair

MName

[5717-Zip 9.22beta

@ Turn Windows features on or
off
Install a program from the = - @
network

EAdobe Reader X (10.1.0) - Deutsch
[ cifX Device Driver (x64) 12,5

@Java 7 Update 7

E} Microsoft Office Standard Edition 2003
H Motepad++

B SvCOM.net for netx

[27 System Requirements Lab for Intel

E Hilscher Gesellschaft fuer Systemautomation mbH

Figure 49: Uninstall or Change a Program Window
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» Select cifX Device Driver entry.
> Above the list, click Uninstall.
2> A security question appears:

E Are you sure you want te uninstall cifX Device Driver (x64) 1.2.x.%7

[] Inthe future, de not show me this dialeg box

Figure 50: Acknowledge Uninstall

> Click Yes.

2 The cifX Device Driver is being uninstalled from your host system or
PC.
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3 USB Driver
3.1 Overview

If a USB interface has been implemented on the carrier board of the host
system of your communication module and if you want to use this USB
interface to configure or diagnose your module or to update its firmware
from a Windows PC, you need to install the USB drivers on your Windows
PC. If you are operating a netJACK communication module with an
Evaluation Board, and if you want to access its USB interface from a
Windows PC, you also need to install the USB driver on your Windows PC.

The USB drivers are delivered on the Communication Solutions DVD.
You can start an installation program for the USB drivers in the menu of the
start screen of the DVD. Instructions for this are provided on the following
pages. You can also start the installation program by double-clicking the
Setup.exe file in the Driver and Toolkit\USB Driver directory of
the Communication Solutions DVD.

The installation program contains all components needed for the installation
of the drivers under Windows XP, Windows Vista, Windows 7 and
Windows 8. It detects, whether the 32 bit or the 64 bit driver needs to be
installed.

Please note the following:

o Always use the installation program, if possible, to install the USB driver,
as described on the following pages.

o If older USB driver versions are installed on your system, uninstall them
first before you install the new version.

¢ Install the USB driver before you connect your communication module to
your Windows PC via USB cable (“software first” principle).

¢ After installing the USB driver and connecting your communication
module via USB cable, check in the Windows Device Manager if the
driver has been correctly installed and if Windows recognizes the
connected communication module.

Note: Before you can use the USB interface of your communication
module, you not only need to install the USB drivers, you also need to
install the module in its host system, PC or Evaluation Board, connect it to
a voltage supply and make sure that it is loaded with its firmware.

When you connect the module to the PC via USB cable, Windows can
identify the appropriate USB driver only if a firmware is running on the
module. Usually, Hilscher communication modules are shipped with their
firmware already loaded. However, you will find information on how to load
or update the firmware of your communication module in the user manual

= comX — Communication Modules for Real-Time-Ethernet and Fieldbus,
DOC100903UMxXEN

or

= netJACK Communication Module — Installation, Operation and
Hardware Description, DOC110504UMxXEN.
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3.2 Installing USB Driver

3.2.1 Installing USB Driver under Windows XP
3.2.11 Installing USB Driver by Installation Program

1. Start the USB driver installation program.

» Insert the Communication Solutions DVD into your local DVD-ROM
drive.

> The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide
Install SYCON.net Configuration Software
Documentation
Drivers, Software and Tools
Install cif / netJACK Device Driver
Ingtall USB Driver
Driver Toolkit for Developer
Ingtall Slave Configuration Software
Augiliary Tools

A& ANooer COLink compaar vevooter> EWICRTS ppmpeus>> i
PoWERLNK Woanus JZ00EE" Googg sercos B hilscher

COMPETENCE 1IN

e
. CORMUNIC ATION

Figure 51: Start Screen Communication Solutions — Install USB Driver

> In the menu, select Drivers, Software and Tools > Install USB Driver.

Note: Alternatively, you can also start the USB driver installation program
(i. e. the Device Driver Installation Wizard) by double-clicking the
setup.exe file in the Driver and Toolkit\USB Driver folder on the
Communication Solutions DVD.
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> The Device Driver Installation Wizard (i. e. the USB driver installation

program) opens:

Device Driver, Installation Wizard

Welcome to the Device Driver
Installation Wizard!

Thiz wizard helps pou install the software drivers that some
computers devices need in order to work.

Ta continue, click Nest.

cBack [ Mewt> |[ Cancel

Figure 52: Device Driver Installation Wizard — Start Screen

2. Start the installation.
> Click Next.
R The installation of the USB drivers is started.

Device Driver Installation Wizard

The drivers are now installing. ..

4

-

Pleaze wait while the drivers install. Thiz may take some time to complete.

< Back Hewt »

Figure 53: Device Driver Installation Wizard — Driver Are Installing
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R After installation, the Completing the Device Installation Wizard
window appears:

Device Driver Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were successtully installed on this computer.

'ou can now connect pour device o this computer, IF pour device
came with instructions, please read them first.

Diriver Mame Statuz
s Hilscher GmbH [net<10s.. FReady to use
»” Hilzcher GmbH [hiluzbze... Readp to uze
s Hilzcher GrbH [libuzb0) ... Ready to use

I Finigh ll Cancel l

Figure 54: Device Driver Installation Wizard — Installation Completed

> Click Finish.

+ Note: Under Windows XP, the installation process is not yet finished after
having executed the Device Driver Installation Wizard.
The installation process has to be completed in the Found New
Hardware Wizard, which automatically opens when you connect the
communication module to a PC via USB cable for the first time.

3. Complete the installation in the Found New Hardware Wizard.

» Connect your communication module via USB cable to your Windows
PC.

X The Found New Hardware Wizard starts:

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard
WWindows will search for current and updated software by

looking ot your computer, on the hardware installation CD, or on
the YWindows Update Web site [with your permizsion).

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

) Yes, this time anly

() Yes. now and gvery time | connect a device

®

Click Mext to continue.

[ Mest » ][ Cancel

Figure 55: Found New Hardware Wizard — USB Driver (1)
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» Answer the question Can Windows connect to Windows Update...?,

by selecting the No, not this time option.
» Click Next.
2 The window with the installation options appears:

Found New Hardware Wizard

Thiz wizard helps you install zoftveare for:

Hilzcher netlaCk

\'} If your hardware came with an installation CD
L2 or floppy disk, insert it now.

w'hat do pou want the wizard to do’Y

(®nstall the software automatically [Fecommended}

() Install fram a list or specific location [Advanced)

Click. Mext to continue.

[ < Back “ Mext » l[ Cancel

Figure 56: Found New Hardware Wizard — USB Driver (2)

» If you have already executed the installation program for the USB driver
(as recommended), you can ignore the wizard’s request to insert a CD
or floppy disk. Answer the What do you want the wizard to do?
guestion by selecting the Install the software automatically option.

> Click Next.

2 Windows copies the driver files to the Windows directories.
Found New Hardware Wizard
Pleaze wait while the wizard installs the software. .. .

3 Hilscher net]ACK.

) L

Setting a syztem restore point and backing up old filez in
case your system needs to be restored in the future.

Figure 57: Found New Hardware Wizard — USB Driver (3)
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2 The Completing the Found New Hardware Wizard window appears:

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished ingtalling the software for;

3 Hilzcher nekl ACK,

Click. Finizh to close the wizard.

Finizh

Figure 58: Found New Hardware Wizard — USB Driver (4)

» Click Finish.
2 The installation of the USB driver is now complete.
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Checking Installation

After having installed the USB driver

and having connected the

communication module via USB cable, you should check in the Windows
Device Manager if the driver has been correctly installed and if Windows

recognizes the communication module.

1. Open the Device Manager.

> In the Start menu of Windows, select Control Panel.

® The Control Panel opens:

B Control Panel

Fle Edit  Wiew

\_) Back -\_)

Favorites  Tools  Help

Lﬁ pSearch H__ Falders v

Address [} Contral Panel

J— Mame =~
ﬂ"" Control Panel = anternet Options
#mKeyhoard
[.} Switch bo Categaory Wiew ';_'] Miouse
ﬂ_-, Metwiark Connections
LPhone and Madern Options
See Also %Power Cptions

2 Printers and Faxes

Q Reqgional and Language Options

I3Scanners and Cameras

[ Scheduled Tasks

@ Security Center

Osoundmax sudiaese

'D», Sounds and Audio Devices

4 speech
Syskem

aTaskbar and Skart Menu

ﬂUser Accounts

a Windows CardSpace

el ‘Windows Firewall

=5 Wireless Mebwork Setup Wizard

% Windows Update
(7] Help and Support

V|GD
A

Camments
Configure your Internet displa. ..
Customize vour kevboard setti,..
Customize your mouse setking. ..
Connects ko other computers, ...
Configure your telephione diali. ..
Configure energy-saving setki...
Shows installed printers and Fa...
Customize settings for the disp. ..
&dd, remove, and configure sc...
Schedule computer tasks to ru...
View wour current secarity skat,..
Soundra AudicESP settings
Change the sound scheme For ...
Change settings for text-to-sp...
See information about your co...
Customize the Start Menu and ...
Change user account settings ...
Yerwalben Sie die zum Anmelde. ..
Configure the Windows Firewall
Set up or add to a wireless net...

W

Figure 59: Control Panel

» Inthe Control Panel, double-click System.
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> The System Properties sheet opens:

System Properties

Syztem Restore Automatic Updates Remote
General Computer Hame Advanced

Device Manager

The Device Manager lists all the hardware devices installed
= oh yaur computer. Use the Device Manager ta change the
properties of any device.

Levice Manager

Drivers

Diivver Signing lets you make sure that installed drivers are
compatible with Wwindows. Windows Update lets you set up
how Windows connects bo Windows Update for drivers.

’ Diriver Signing ] [ Windows Update

Hardware Profiles

Hardware profiles provide a way for pou to et up and store
different hardware configurations.

’ Hardware Profiles ]

[ Ok, H Cancel ]

Figure 60: System Properties

» Inthe System Properties sheet, select Hardware tab.
» Inthe Hardware tab, click Device Manager.
2 The Device Manager starts:

£ Device Manager

File  fAction  Wiew  Help

& 2 =R
‘¢ Computer ”~
g Disk drives

§ Display adapters
i DWDJCD-ROM drives
= Floppy disk controllers
ﬁ. Floppy disk drives
8 Human Interface Devices
=% IDE ATAIATAPI controllers
‘Z Kevboards
"y Mice and other painting devices
# Monitors
E& Mebwork adaphers
5 Ports (COM &.LPT)
# Communications Pork (COMLY
- ECP Printer Port (LPT1)
B Hilscher st 1A 1)
# InteliR) Active Management Technology - SOL (COM3)
ﬂ Processars
. sound, video and game contrallers

Syskem devices
Universal Serial Bus contraollers [

o o s O O e R Bl B I

+- -

Figure 61: Display of USB Connection in Device Manager
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2. Check if the communication module is recognized.
» Click on the plus symbol in front of the Ports (COM & LPT) entry.

2 A netJACK NJ 100EN-RE communication module for instance will be
displayed as Hilscher netJACK, with the currently used COM port
indicated in brackets.
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3.2.2 Installing USB Driver under Windows 7
3.2.2.1 Installing USB Driver by Installation Program

1. Start the USB Driver setup program.

» Insert the Communication Solutions DVD into your local DVD-ROM
drive.

R The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide
Install SYCON.net Configuration Software
Documentation
Drivers, Software and Tools
Install cif / netJACK Device Driver
Ingtall USB Driver
Driver Toolkit for Developer
Ingtall Slave Configuration Software
Augiliary Tools

£ Nooor CCLink comona® et EOT cpi> o=

—

) m am f : T g
IPOWERLl NK *‘lﬂdbus %# E%%%%E ﬁe PGO& <:‘“$ h il&%@ﬂ@?

WARAN COMPETENCE 1IN

. CORMUNIC ATION

Figure 62: Start Screen Communication Solutions — Install USB Driver

> In the menu, select Drivers, Software and Tools > Install USB Driver.

Note: Alternatively, you can also start the USB driver setup program (i. e.
the Device Driver Installation Wizard) by double-clicking the setup.exe
file in the Driver and Toolkit\USB Driver folder of the
Communication Solutions DVD.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO1EN | Revision 1 | English | 2013-10 | Released | Public © Hilscher 2013



USB Driver

52/116

> The Device Driver Installation Wizard (i. e. the USB driver installation

program) opens:

Device Driver Installation Wizard

- Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

Bsck || Net> | | Cancel

Figure 63: Device Driver Installation Wizard — Start Screen

2. Start the installation.
> Click Next.
R The installation of the USB drivers is started.

Device Driver Installation Wizard

The drivers are mow installing._ :5

(o =

Please wait while the drivers install. This may talee some time to complete.

< Back Mext >

Figure 64: Device Driver Installation Wizard — Drivers Are Installing
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R After installation, the Completing the Device Installation Wizard

window appears:

Device Driver Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

*You can now connect your device to this computer. I your device

came with instructions, please read them first.

Driver Name Status

» Hilscher GmbH (net<10s... Readyto use
» Hilscher GmbH (hilusbse... Readyto use
» Hilscher GmbH (ibusb0) ... Readyto use

Bsck || Finish | | Cancel

Figure 65: Device Driver Installation Wizard — Installation Completed

> Click Finish.
R The installation of

the USB driver is completed.

__} Note: By completing the Device Driver
installation process under Windows 7 is practically finished.

Installation Wizard, the

When you connect the communication module to the PC via USB cable
for the first time, the Installing device driver software message appears
in the Windows task bar. Windows then copies the driver files to the
appropriate Windows directories. This is an automated process, you do
not need to take any action in this. Finally, the Device driver software

installed successfully message appears in the task bar.
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Checking Installation

After having

installed the USB driver

and having connected the

communication module via USB cable, you should check in the Device
Manager of Windows 7 if the driver has been correctly installed and if
Windows recognizes the communication module.

1. Open the Device Manager.

> In the Windows Start menu, select Control Panel.

> The Control Panel opens:

O@vl@ + Control Panel »

Adjust your computer's settings

System and Security
Review your computer's status
Back up your cemputer

Find and fix preblems

Network and Internet
View network status and tasks
Cheose homegroup and sharing
opticns

Hardware and Sound

%‘ View devices and printers
Add a device
E—% Programs
; & Uninstall a pregram
4

Get programs

€ ¢ &K

- | + Search Control Panel |
1

View by: Category =

User Accounts
'?ﬁ' Change account type

Appearance and
Personalization
Change the theme

Change desktop background
Adjust screen resclution

Clock, Language, and Region
Change keyboards or ather input
methods

Change display language

Ease of Access
Let Windows suggest settings
Optimize visual display

Figure 66: Adjust Your Computer’s Settings Window

> In the Control Panel, click Hardware and Sound.
> The Hardware and Sound window opens:

.
@legﬁ » Control Panel » Hardware and Sound »

Contrel Panel Home

‘ .;"
2y 7
System and Security 'I podaevice
Network and Internet @ AutoPIay

® Hardware and Sound

Programs

User Accounts Sound

E

Appearance and
Personalization

Clock, Language, and Regicn

Ease of Access

Display

=

Devices and Printers
Add a printer

Change default settings for media or devices
Play CDs or other media automatically

Adjust system volume

Power Options
Change power-saving settings
Require a password when the computer wakes
Change when the computer sleeps

Make text and other items larger or smaller
Connect to an external display

- | *y | | Search Control Panel

Change system sounds

Mouse '&'Devicel‘ﬂanager

Manage audio devices

Change what the power buttons do

Choose a power plan

Adjust screen resclution
How to correct monitor flicker (refresh rate)

Figure 67: Hardware and Sound Window
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» Inthe Devices and Printers group, click Device Manager.
> The Device Manager starts:

=1 Device Manager EI@

Eile Action View Help
= @ E HmE E RS

4= im01lwin7

b ¥ CIF Communication Interface
> 18 Computer

-+ Disk drives

- B Display adapters

> - DVD/CD-ROM drives

> = Floppy disk drives

> .._:H Floppy drive controllers

b .v,"“] Human Interface Devices

b ‘g IDE ATA/ATAPT controllers
.S Keyboards

b }3 Mice and other pointing devices
b - Monitors

:s ¥ Metwork adapters

» -3y Other devices

JT Ports (COM 8L LPT)

Y2 ECP-Druckeranschluss (LPT1)
"= Hilscher net)ACK (COM3)

——

b 2 Processors

b -4 Sound, video and game controllers
> 78 System devices

b - ¥ Universal Serial Bus controllers

Figure 68: Display of USB Connection in Device Manager

2. Check if the communication module is recognized.
» Click on the triangle in front of the Ports (COM & LPT) entry.

2 A netJACK NJ 100EN-RE communication module for instance will be

displayed as Hilscher netJACK, with the currently used COM port
indicated in brackets.
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3.2.3 Installing USB Drivers under Windows 8
3.2.3.1 Installing USB Driver by Installation Program

1. Start the USB Driver setup program.

» Insert the Communication Solutions DVD into your local DVD-ROM
drive.

R The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide
Install SYCON.net Configuration Software
Documentation
Drivers, Software and Tools
Install cif / netJACK Device Driver
Ingtall USB Driver
Driver Toolkit for Developer
Ingtall Slave Configuration Software
Augiliary Tools

£ Nooor CCLink comona® et EOT cpi> o=

—

) m am f : T g
IPOWERLl NK *‘lﬂdbus %# E%%%%E ﬁe PGO& <:‘“$ h il&%@ﬂ@?
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Figure 69: Start Screen Communication Solutions — Install USB Driver

> In the menu, select Drivers, Software and Tools > Install USB Driver.

Note: Alternatively, you can also start the USB driver setup program (i. e.
the Device Driver Installation Wizard) by double-clicking the setup.exe
file in the Driver and Toolkit\USB Driver folder of the
Communication Solutions DVD.
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> The Device Driver Installation Wizard (i. e. the USB driver installation
program) opens:

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click Next.

<Back | Net> | | Cancel

Figure 70: Device Driver Installation Wizard — Start Screen

2. Start the installation.
> Click Next.
R The installation of the USB drivers is started.

The drivers are now installing.... .

Please wait while the drivers install. This may take some time to complete.

Figure 71: Device Driver Installation Wizard — Drivers Are Installing
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R After installation, the Completing the Device Installation Wizard
window appears:

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. f your device
came with instructions, please read them first.

Driver Name Status

~ Hischer GmbH {netx10ser) Ports ... Readyto use
~ Hischer GmbH fhilusbser) Ports {... Readyto use
£

< Back Cancel

Figure 72: Device Driver Installation Wizard — Installation Completed

» Click Finish.
2 The installation of the USB drivers is completed.

Note: By completing the Device Driver Installation Wizard, the
installation process under Windows 8 is practically finished. When you
connect the communication module to your PC via USB cable for the first
time, the following symbol appears in the task bar (visible only if you are in
the “desktop mode” of Windows 8):

Ly

Windows then copies the driver files to the appropriate Windows
directories. This is an automated process, you do not need to take any
action in this.
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3.2.3.2 Checking Installation

After having installed the USB driver and having connected the
communication module via USB cable, you should check in the Device
Manager of Windows 8 if the driver has been correctly installed and if
Windows recognizes the communication module.

1. Open the Control Panel.
» In the Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 73: All Apps Button

» Click All apps.
2 A list featuring all available programs (Apps) appears:

Sound Recorder
T-Zip File Manager — | Command Prompt
Sticky Motes 5 Computer
Word
Control Panel
Photos - E f  Notepad++ J Vindows Default Programs
| Reader Mi Cli ws Mediz File Explorer
SkyDrive 0, Mic 0 Calculator WordPad Help and Support
9

Sparts by i ffice Character Map e Run

Store [ Mi ft Offi Math Input Panel i Task Manager

Travel ] C Office Notepad L Magnifier > Windows Defender
= o

Video S ce Paint Narrator

snipping Tool

Figure 74: List of Installed Apps in Windows 8

» Inthe Apps list, click Control Panel.
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2 Windows 8 changes into “desktop mode” and opens the Control Panel:

4+ [ v Control Panel »

Adjust your computer’s settings

System and Security

Review your computer's status

Save backup copies of your files with File
History

Find and fix problems

_ Network and Internet
i' View network status and tasks
3 Cheose homegroup and sharing options

Hardware and Sound
View devices and printers

|Search Control Panel

v &

Wiew by:  Category =

User Accounts
@ Change account type

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen resolution

Clock, Language, and Region
Add a language

Change input methods

Change date, time, or number formats

Add a device

Ease of Access
Let Windows suggest settings
Optimize visual display

Programs
Uninstall a pregram
Get programs

2,
N,
@

Figure 75: Control Panel

2. Open Device Manager.
» In the Control Panel, click Hardware and Sound.
2 The Hardware and Sound window opens:

@ - 4 % v Control Panel » Hardware and Sound » v O Search Control Panel

Control Panel Home c B
Devices and Printers

Add a device
Change Windows To Go startup eptions

-
Lo

Advanced printer setup | Mouse @ Device Manager

Systern and Security

Metwerk and Internet
Hardware and Sound

AutoPlay

Change default settings for media or devices | Play CDs or other media automatically

Programs
Sound
Adjust system volume

User Accounts
Change system sounds | Manage audic devices

Appearance and
Personalization

Power Options

Change power-saving settings
Require a password when the computer wakes
Choose a power plan

Clock, Language, and Region Change what the power buttons do

Ease of Access Change when the computer sleeps

Display
Make text and other items larger or smaller
How to correct monitor flicker (refresh rate)

;€ QO

Adjust screen reselution

Location Settings
Change lecation settings

Figure 76: Hardware and Sound
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» Inthe Devices and Printers group, click Device Manager.
> The Device Manager starts:

Eile Action View Help
e || E HE | B %S

a = im0lwing
i+ /M Computer

— Disk drives

‘5‘1 Display adapters

& DVD/CD-ROM drives

= Floppy disk drives

l:E Floppy drive controllers

% Human Interface Devices

g |IDEATASATAPI controllers

= Keyboards

ﬁ Mice and other pointing devices

EJ Monitors

I? Metwork adapters

\l5) Other devices

" Ports (COM & LPT)
P ECP-Druckeranschluss (LPT1)
[T Hilscher net/ ACK (COM4) |
"? Kammunikationsanschluss (COMT)

[ @ Print queues

[ R Processors

[ iﬂ' Sound, video and game controllers

[ C— Storage controllers

i M System devices

[
[»
[»
[
[
[»
[
[
[»
[
[
[»
4

p i Universal Serial Bus controllers

Figure 77: Display of USB Connection in Device Manager

3. Check if the communication module is recognized.
» Click on the triangle in front of the Ports (COM & LPT) entry.

2 A netJACK NJ 100EN-RE communication module for instance will be
displayed as Hilscher netJACK, the currently used COM port is
indicated in brackets.
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3.3 Uninstalling USB Driver

3.3.1 Uninstalling USB Driver under Windows XP

If you want to uninstall the USB drivers under Windows XP, proceed as

follows:

> In the Start menu of Windows XP, select Control Panel.

® The Control Panel opens:

B Control Panel

Fil=

\_) Back -\_)

Edit Wiew Faworites Tools  Help

Lﬁ pSearch H__ Falders v

Address [} Contral Panel

Mame =
Qp Accessibility Options
E ndd Hardware

ﬂ"' Control Panel S

[.} Switch bo Categaory Wiew

See Also

; e Programs

4@ Adrinistrative Tools

‘u Autarnatic Updates

!-! cif Setup

P ciF % Test

< Datke and Time

} Display

Flash Player

| Falder Options

ﬁ Fonts

& Game Controllers

‘ﬁlndexerstellung

Ed trtei(ry ama Driver
anternet Cpkions

@ Kevboard

) Mause

ﬂ_, Metwork Connections
LPhone and Madem Options
G

% Windows Update
(7] Help and Support

V|GD
A

Adjust wour computer settings ...
Installs and troubleshoots hat...
h Install or remove pragrams an...
Configure administrative settin...
Set up Wwindows ko autormatical. ..
Setup cif Boards and channels
Test your cify Boards and Cha. ..
Set the date, time, and time z...
Change the appearance of vo...
Manage Flash Plaver Settings
Customize the display of files a...
&dd, change, and manage fon...
&dd, remove, and configure g...
Microsoft Office Find Fast {tm). ..
Stewern Sie die Grafikhardwar..,
Configure your Internet displa. ..
Customize vour kevboard setti, ..
Customize your mouse setking...
Connects to other computers, ..
Configure your telephone diali, ..

Camments

W

Figure 78: Control Panel

» Inthe Control Panel, double-click Add or Remove Programs entry.
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? The Add or Remove Programs window opens:

% Add or Remove Programs EFXI

[
il Currently installed programs: [ show updates Sork by

Change or - Size  Z77SME
Remaove =
Programs ‘ﬁ! Size 2.87ME
; 'i Entries from other programs
; MF Size 335.00MEBE
Add Mew .
e i Sz 2.16MB
.13 Size  10.31MB
@ i Size  22.42MB
Add/Fenmove am Sz 0.82ME
Windows
Components |3 Size  3.69MB
@ O Size  0.16MB
i Size  2.91MB
Set Pragram .
#ccess and h_g Size  228.00MB
Defaults
Size  7.42MB

& Windows Driver Package - Hilscher @mbH (libusb} ibusb-win3z devices (12f20/2012 1,2.4.00
& wWindows Driver Package - Hilscher GmbH (netx10ser) Ports (10/01)2012 6,0,7.00

1<

Figure 79: Add or Remove Programs

» Select Windows Driver Package — Hilscher GmbH (hilusbser) Ports
entry.

» Click Change/Remove.
2> A security question appears:

Uninstall Driver Package

\_g/. All devices using this driver will be removed, Do wou wish to continue?

Figure 80: Acknowledge Uninstall

» Click Yes.
> The USB driver package is removed from your PC.

» Repeat this procedure for the remaining driver packages
Windows Driver Package — Hilscher GmbH (libusb0) [...] devices
and Windows Driver Package — Hilscher GmbH (netx10ser) Ports.
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3.3.2 Uninstalling USB Driver under Windows 7
> In the Start menu of Windows 7, select Control Panel.
® The Control Panel opens:
o[- ]
O@v|@ » Control Panel » - | +y | | |Search Control Panel jel |
Adjust your computer’s settings View by: Category =
gl  Systemand Security User Accounts
3 Review your computer's status [ @) Change account type
; Back up your computer - d e
Find and fix problems Appearance and
w,_ Network and Internet w Personalization
ul View netwerk status and tasks Change the theme
- Choose homegroup and sharing options Change desktop background
Adjust screen resolution
, / Hardware and Sound _ .
%‘ View devices and printers Clock, Language, and_ Region
Add a device | Change keybeards or other input
/ methods
H“f Programs Change display language
g Uninstall a program @ Ease of Access
4 Get programs ( b . .
I | Let Windows suggest settings
\—-/ Optimize visual display
Figure 81: Adjust Your Computer’s Settings Window
» Inthe Programs group, click Uninstall a program.
2 The Uninstall or change a program window opens:
[E=% Nol 5
@uv <« Programs » Programs and Features - | 3 | | Search Programs and Features o |
Control Panel H .
R Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or
B Turn Windows features on or Repair.
off
Install a program from the Organize *  Uninstall/Change i .@.
network =
MName o
CE|
1 Entries from other programs
|
CE|
@
D e
=
nek=:
ko =
|
»
]
& Windows Driver Package - Hilscher GmbH (hilusbser) Ports (12,/21/2012 6.0.9.0) e
& Windows Driver Package - Hilscher GmbH (libusb0) libusb-win32 devices (12/20,/20121.2.4.
& Windows Driver Package - Hilscher GmbH (nebdOser) Ports (10/01/2012 6.0.7.0) 7
1| 1 | L
@" Hilscher GmbH Product version: 12/21/2012 6.0.9.0
<

Figure 82: Uninstall or Change a Program
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>

>

Select Windows Driver Package — Hilscher GmbH (hilusbser) Ports
entry.

Click Uninstall/Change button located above the list.

2> A security question appears:

Uninstall Driver Package £

{e} All devices using this driver will be removed. Do you wish to continue?

Figure 83: Acknowledge Uninstall

Click Yes.
The USB driver package is removed from your PC.

Repeat this procedure for the remaining driver packages
Windows Driver Package — Hilscher GmbH (libusbO) [...] devices
and Windows Driver Package — Hilscher GmbH (netx10ser) Ports.
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3.3.3 Uninstalling USB Driver under Windows 8

1. Open the Control Panel.
» In the Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 84: All Apps Button

» Click All apps.
2 A list featuring all available programs (Apps) appears:

Sound Recorder

Dokument
MNews 7-Zip File Manager By Micro Steps Recorder En Command Prompt

n Office-Dokument 7-Zip Help Sticky Motes 5 Computer

= offnen
People Window: Control Panel
a = Scan
Photos - Signatur f | Notepad++ ‘Windows Journal Default Programs.

BA-Projekte

Reader File Explorer

SkyDrive =} i f Calculator 1 Help and Support

Sparts b i ic Office Character Map e Run

Store Math Input Panel . Task Manager
MNotepad L Magnifier g ‘Windows Defender
Video . I Office Marrator

Weather

Snipping Tool

Figure 85: List of Installed Apps in Windows 8

» Inthe Apps list, click Control Panel.
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2 Windows 8 changes into “desktop mode” and opens the Control Panel:

1+ [ » Control Panel »

Adjust your computer’s settings

System and Security

Review your computer's status

Save backup copies of your files with File
History

Find and fix preblems

_ Network and Internet
| View network status and tasks
Cheoose homegroup and sharing options

Hardware and Sound
View devices and printers
Add a device

Programs
Uninstall a pregram
Get programs

Figure 86: Control Panel

v & |Search Control Panel

View by: Category *

User Accounts
'@] Change account type

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen reselution

Clock, Language, and Region
Add a language

Change input metheods

Change date, time, or number formats

Ease of Access
Let Windows suggest settings
Qptimize visual display

2. Open Programs and Features window.
» In the Programs group of the Control Panel, click Uninstall a

program.

 The Programs and Features window opens:

= 4 |5l « Programs » Programs and Features

Control Panel Home

View installed updates

@' Turn Windows features on or
off

Install a program from the
network MName

Organize *  Uninstall/Change

v & Search Programs and Features 0O

Uninstall or change a program

To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

B=

Entries from other programs

|xWindaws Driver Package - Hilscher GmbH (hilusbser) Ports (12/21/2012 6.0.9.0)

E Windows Driver Package - Hilscher GmbH (libusb0) libusb-win32 devices (12/20/2012 1.2.4.0)
E Windows Driver Package - Hilscher GmbH (netx10ser) Ports (10/01/2012 6.0.7.0)

<

§ Hilscher GmbH Product version: 12/21/2012 6.0.9.0
—

Figure 87: Uninstall or Change a Program
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3. Uninstall driver packages.

» Select Windows Driver Package — Hilscher GmbH (hilusbser) Ports
entry.

» Click Uninstall/Change button located above the list.
> A security question appears:

Uninstall Driver Package ﬂ

0 All devices using this driver will be removed. Do you wish to continue?

Figure 88: Acknowledge Uninstall

» Click Yes.
> The USB driver package is removed from your PC.

» Repeat this procedure for the remaining driver packages
Windows Driver Package — Hilscher GmbH (libusbO0) [...] devices
and Windows Driver Package — Hilscher GmbH (netx10ser) Ports.
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4 SYCON.net
4.1 Overview

With the SYCON.net configuration software, you can configure and
diagnose your communication module. You can also use it to download or
update the firmware of your module.

If the host system of your communication module runs under a Windows
operating system, you can install SYCON.net directly on your host system
for the above mentioned purposes. You can also install SYCON.net on a
separate configuration PC under Windows, and then connect your
communication module via PCI Carrier Board (comX), Evaluation Board
(netJACK), USB or serial interface to the configuration PC and SYCON.net.

SYCON.net is delivered on the Communication Solutions DVD. You can
start the installation program for SYCON.net (the SYCON.net for netX
InstallShield Wizard) in the menu of the start screen of the DVD.
Instructions for this are provided on the following pages. You can also start
the installation by double-clicking the SYCONnNet netX setup.exe file in the
Software\SYCON.net directory of the Communication Solutions DVD.
The installation program contains all components needed for the installation
under Windows XP, Windows Vista, Windows 7 and Windows 8.

Please note the following:

¢ If SYCON.net shall access the communication module via host interface
or PC bus, you need to install the cifX Device Driver on your host system
or configuration PC. See cifX Device Driver chapter on page 9.

¢ If SYCON.net shall access the communication module via USB, you
need to install the USB Driver on your host system or configuration PC.
See USB Driver chapter on page 42.

¢ You need administrator rights for installing or uninstalling SYCON.net on
your operating system.

¢ |If an older version of SYCON.net is already installed on your system,
uninstall it first, before you install the new version. See Uninstalling
SYCON.net section on page 86.
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4.2 System Requirements

To install and use SYCON.net, the following requirements must be met:

PC with 1 GHz processor or higher

Windows® XP SP3, Windows® Vista (32 bit) SP2, Windows® 7 (32 bit)
SP1, Windows® 7 (64 bit) SP1, Windows® 8 (32 bit) or Windows® 8 (64
bit)

Administrator privilege required for installation

Internet Explorer 5.5 or higher

Free disk space: min. 400 MByte

DVD ROM drive

RAM: min. 512 MByte, recommended 1024 MByte

Graphic resolution: min. 1024 x 768 pixel

Keyboard and Mouse

USB, serial or Ethernet interface

Note: If the project file is saved and opened again or if it is used on
another PC, the system requirements must match. Particularly the DTM
must be installed on the used PC.

Restriction
Touch screen is not supported.
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4.3 Installing SYCON.net
4.3.1 Installing SYCON.net under Windows XP

1. Start the SYCON.net installation program.

» Close all application programs and insert the Communication Solutions
DVD into the local DVD-ROM drive.

2 The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide

Install SY'GOK. net Configuration Sofhware
Ciocumentation

Drivers, Software and Toals

£ ANopen CCLink compier> pereoter® EWrChT ppier> 7=
CHEENL - . o . i < . )
FoweaLik Woanus ZEEERE GERZEE Sercos g hilscher

. CORMMUNICATION

Figure 89: Start Screen Communication Solutions — Install SYCON.net

» Click on Install SYCON.net Configuration Software.

Note: As an alternative, you can also start the SYCON.net installation
program (i. e. the SYCON.net for netX InstallShield Wizard) by double-
clicking the SYCONnRet netX setup.exe file in the Software\SYCON.net
directory on the Communication Solutions DVD.

2 The SYCON.net installation program is started.

2. Choose language for the setup.

Wihlen Sie eine Setup-Sprache aus

‘wiahlen Sie die Sprache dieser Installation aus der unten
@ aufgefiihrten Auswahl aus.

English [United States)

[ DK || abbrechen |

Figure 90: SYCON.net Setup Language

» Select the language for the setup.
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> Click OK.

2 The SYCON.net for netX InstallShield Wizard opens:

Welcome to the InstallShield Wizard for
SYCON.net for netx

The Installshisld(R) Wizard will install S¥COM,.net For nets,
version 1.x on your computer, To continue,
click Mext.

WWARNMING: This program is protected by copyright law and
international treaties,

i SYCON. net for netX - InstaliShield Wizard X

[ mets [ Cancel

]

Figure 91: SYCON.net Installation Program

» Click Next.

3. Read the notes about major changes in SYCON.net.

5 SYCON. net for, net¥ - InstallShield Wizard

Important Information ‘J "‘
Please read the followinig information carefully, e |

Notes about major changes in SYCON.net v1.x

Flease read these notes carefully, since they contain important information about
major changes in SYC0M.net.

Overview
1. Concerns com¥ Communication Modules
1.1, Opening old ¥ COMN.net Project Files

2.  Concerns cif¥ Communication Interfaces and com¥ Communication
Modules

& information yet

|£

[ < Back ” Mexk = ] [ Cancel

]

Figure 92: Notes About Major Changes in SYCON.net

» Read the notes about major changes in SYCON.net carefully.

» Select | read the information after you have read them.

> Click Next.
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4. Accept license agreement.

& SYCON. net for net¥ - InstallShield Wizard

License Agreement Tl

Flease read the Following license agreement carefully,

HILSCHER SOFTWARE LICENSE AGREEMENT

This document is a legally walid contract between you and Hilzcher Gesellzchatt fir
Systemautomation mhH ("Hilscher").

Fleasze read through this License Agreement carefully before instaling and using the
=oftware. By installing the software and using it, whether in wwhole or in part, you accept all
of the provisions of this Agreement.

If vou decline to accept these terms and conditions, please do not install the software.
Instead, return it to us or the retailer from which you purchased it for a refund of the
purchase price. b

(21 accept the kerms in the license agreement:

()1 do not accept the terms in the license agreement

[ < Back " Mext = l ’ Cancel

Figure 93: SYCON.net License Agreement

» Select | accept the terms in the license agreement, if you agree to it.
» Click Next.

5. Enter user information.

{2 SYCON. net for net¥ - InstallShield Wizard

Customer Information - 'J

Please enter your information.

Uset Marne:
|L|ser N,IEII'ﬂB

Qrganization:

|Organi2ati0n

[ < Back " Mext = ] [ Cancel

Figure 94: SYCON.net Customer Information

» Enter the user name and the name of the organization.
» Click Next.
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6. Select setup type.

i'—;zx" SYCON. net for netx - InstallShield Wizard

Setup Type

Chaose the setup type that best suits your needs,

Please select a setup type,

Al program Features will be installed. (Requires the most disk
space.)

O Custom

Choose which program Features you want installed and where they

@ will be installed, Recommended for advanced users,

[ < Back ][ Mext = ] [ Cancel

Figure 95: SYCON.net Setup Type

» Select Complete if you want to install the complete software.
» Click Next.

7. Install SYCON.net.

i SYCON. net for net¥ - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation.

Click Install ko begin the installation.

IF wou want to review or change any of vour installation settings, dlick Back. Click Cancel to
exit the wizard,

[ <Back  [[ Instal ’ Cancel

Figure 96: Start SYCON.net Installation

» Click Install to start the installation.
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2 The components are being installed. This may take several minutes.

{& SYCON.net for netX - InstallShield Wizard

Installing SYCON.net for netX

The program features vou selected are being installed,

Please wait while the InstallShield Wizard installs SYCOM, net for nety. This
may take several minutes,

Status:

Cancel

Figure 97: SYCON.net Installation Status

8. Finish Installation.
it SYCON.net for netX - InstallShield Wizard X

InstallShield Wizard Completed

The Installshield wWizard has successfully installed S¥CON. net
for net, Click Finish ko exit the wizard,

< Back Cancel

Figure 98: Finish SYCON.net Installation

» Click Finish to complete the installation.

2 SYCON.net is installed and can be started in the Start menu of

Windows by choosing All Programs > SYCON.net

Configurator > SYCON.net.

System
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4.3.2 Installing SYCON.net under Windows 7

1. Start the SYCON.net installation program.

» Close all application programs and insert the Communication Solutions
DVD into the local DVD-ROM drive.

2 The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

. SO MUNIGATIGN

Installation Guide

Install SY'COM.net Configuration Software
Documentation

Cirivers, Software and Tools

£ ANooco CCLinK ot oooater® EMerchT™ o> &
ovER Wocous B0 o Rerces i Pl

—

the sutoemation bus o) ECOMPETENCE IN

Figure 99: Start Screen Communication Solutions — Install SYCON.net

» Click on Install SYCON.net Configuration Software.

Note: As an alternative, you can also start the SYCON.net installation
program (i. e. the SYCON.net for netX InstallShield Wizard) by double-
clicking the SYCONnNet netX setup.exe file in the Software\SYCON.net
directory on the Communication Solutions DVD.

You can reduce the number of Windows security questions by right-
clicking on the SYCONnRet netX setup.exe file and choosing Run as
administrator from the context menu.

» The SYCON.net installation program is started.

2. Choose language for the setup.

F ™
Choose Setup Language ﬁ

@ Select the language for this installation from the choices below.
]

[Englisch (Us4) -]

[ 0K ] ’ Cancel ]

%

Figure 100: SYCON.net Setup Language
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» Select the language for the setup.
> Click OK.

2 The SYCON.net for netX InstallShield Wizard opens:

[~ ™
1) SYCON.net for netX - InstaliShield Wizard . s

Welcome to the InstallShield Wizard for
SYCON.net for netX

The Installshield(R) Wizard will install SYCON.net for netx,
version 1.x on your computer, To continue,
dlick Mext.

WARNING: This program is protected by copyright law and
international treaties.

< Back [ Mext = ] [ Cancel

Figure 101: SYCON.net Installation Information

> Click Next.

3. Read the notes about major changes in SYCON.net.

[~ ™
1) SYCON.net for netx - InstallShield Wizard |l s

Important Information
Please read the followinig information carefully.

Notes about major changes in SYCON.net V1.x a
Please read these notes carefully, since they contain important information about
major changes in SYCOM.net.

Overview
1. Concerns comX Communication Modules
1.1. Opening old SYCON.net Project Files

2. Concerns cifX Communication Interfaces and comX Communication
Modules 2

() I have not read the information yet

InstallShield

[ < Back ][ Mext = J [ Cancel

Figure 102: Notes about Major Changes in SYCON.net

» Read the notes about major changes in SYCON.net carefully.

» Select | read the information, after you have read them.

> Click Next.
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4. Accept license agreement.

License Agreement

Flease read the following license agreement carefully.

_
) SYCON-net for netX - InstallShield Wizard [

HILSCHER SOFTWARE LICENSE AGREEMENT

L This document is a legally valid contract between you and Hilscher Gesellschaft fir
Systemautemation mbH (“Hilscher™).

Please read through this License Agreement carefully before installing and using the
software. By instaling the software and using it, whether in whole or in part, you accept all
of the provisions of this Agreement.

| |If you decline to accept these terms and conditions, please do not install the software.
Instead, return it to us or the retailer from which you purchased it for a refund of the
" |purchase price.

() I do not accept the terms in the license agreement

InstaliShield

[ < Back ][ Mext = J [ Cancel

Figure 103: SYCON.net License Agreement

» Select | accept the terms in the license agreement, if you agree to it.

> Click Next.

5. Enter user information.

-
ﬂ SYCON.net for netX - InstallShield Wizard-

Customer Information

Please enter your information.

User Name:

i |User Mame

Qrganization:

IDrganizat’on

Installshield

[ < Back ][ Mext = J [ Cancel

Figure 104: SYCON.net Customer Information

» Enter the user name and the name of the organization.

> Click Next.
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6. Select setup type.

.
'_'@ SYCOM.net for netX - InstallShield Wizard

Setup Type
Choose the setup type that best suits your needs.

Pleaze select a setup type.

All program features will be installed. (Requires the most disk
space.)

Choase which program features you want installed and where they
will be installed. Recommended for advanced users.

InstaliShield

[ < Back ][ Mext = ] [ Cancel

Figure 105: SYCON.net Setup Type

» Select Complete if you want to install the complete software.

> Click Next.

7. Install SYCON.net.

.
'_'@ SYCOM.net for netX - InstallShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

InstaliShield

[ <Back [f  Install [ Cancel

Figure 106: Start SYCON.net Installation

> Click Install to start the installation.
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2 The components are being installed. This may take several minutes.

F B
5] SYCOMN.net for netX - InstaliShield Wizard [

Installing SYCON.net for netX
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs SYCON.net for netX. This
may take several minutes.

Status:
Copying new filles
—

InstaliShield

< Back Mext =

A

Figure 107: SYCON.net Installation Status

8. Finish Installation.

F B
5] SYCOMN.net for netX - InstaliShield Wizard [

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed SYCOM.net
for netX, Click Finish to exit the wizard,

b

Figure 108: Finish SYCON.net Installation

» Click Finish to complete the installation.

R SYCON.net is installed and can be started in the Start menu of

Windows by choosing All Programs > SYCON.net System
Configurator > SYCON.net.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO1EN | Revision 1 | English | 2013-10 | Released | Public © Hilscher 2013



SYCON.net

81/116

4.3.3 Installing SYCON.net under Windows 8

1. Start the SYCON.net installation program.

» Close all application programs and insert the Communication Solutions
DVD into the local DVD-ROM drive.

2 The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide

Install SY'COM.net Configuration Software
Documentation

Cirivers, Software and Tools

£ ANt CCLink comow™ omter EHrehT cpiurr> o=
rowgiink Woaeue RGBS ROZEY sercos [ —otli

. SO MUNIGATIGN

—

Figure 109: Start Screen Communication Solutions — Install SYCON.net

» Click on Install SYCON.net Configuration Software.

Note: As an alternative, you can also start the SYCON.net installation
program (i. e. the SYCON.net for netX InstallShield Wizard) by double-
clicking the SYCONnNet netX setup.exe file in the Software\SYCON.net
directory on the Communication Solutions DVD.

You can reduce the number of Windows security questions by right-
clicking on the SYCONnRet netX setup.exe file and choosing Run as
administrator from the context menu.

» The SYCON.net installation program is started.

2. Choose language for the setup.

g Select the language far this ingtallation from the chaoices below,
]

Englizh [United States)

Figure 110: SYCON.net Setup Language
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» Select the language for the setup.
> Click OK.
2 The SYCON.net for netX InstallShield Wizard opens:

Welcome to the InstallShield Wizard for
SYCON.net for netX

The InstallShield(R) Wizard will install SYCON.net for netX,
version 1.3560,130301.9398 on your computer. To continue,
dlick Next.

WARNING: This program is protected by copyright law and
international treaties,

[ Mext> | | Cancel

Figure 111: SYCON.net Installation Information

> Click Next.

3. Read the notes about major changes in SYCON.net.

Important Information

Please read the followinig information carefully.

Notes about major changes in SYCON.net V1.350.x.x

Please read these notes carefully, since they contain important information about
major changes in SYCON.net.

Overview

1. Concerns Communication Modules comX

1.1. Opening old SYCON.net Project Files

2. Concerns PC Cards cifX and Communication Modules comX

(_)1 have not read the information yet

InstallShield

Figure 112: Notes about Major Changes in SYCON.net

» Read the notes about major changes in SYCON.net carefully.
» Select | read the information, after you have read them.
» Click Next.
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4. Accept license agreement.

License Agreement

Pleaze read the following license agreement carefully.

HILSCHER SOFTWARE LICENSE AGREEMENT

This document is a legally valid contract between you and Hilscher Geselschaft fir
Systemautomation mbH (*Hilscher™).

Please read through this License Agreement carefulty before installing and using the
software. By installing the software and using it, whether in whole or in part, you accept all
of the provisions of this Agreement.

If you decline to accept these terms and cenditions, please do not install the software.
Instead, return it to us or the retailer from which you purchased it for a refund of the
purchase price.

(7)1 do not accept the terms in the license agreement:

InstaliShield

Figure 113: SYCON.net License Agreement

» Select | accept the terms in the license agreement, if you agree to it.
» Click Next.

5. Enter user information.

Customer Information

Please enter your information.

User Mame:
|

Organization:

Installshield

Figure 114: SYCON.net Customer Information

» Enter the user name and the name of the organization.
» Click Next.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO1EN | Revision 1 | English | 2013-10 | Released | Public © Hilscher 2013



SYCON.net 84/116

6. Select setup type.

Setup Type
Choose the setup type that best suits your needs.

Pleaze select a setup type.

All program features will be installed. (Requires the most disk
space.)

Choose which program features you want installed and where they
will be installed. Recommended for advanced users,

InstaliShield

Figure 115: SYCON.net Setup Type

» Select Complete if you want to install the complete software.
» Click Next.

7. Install SYCON.net.

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Badk. Click Cancel to
exit the wizard,

InstaliShield

Figure 116: Start SYCON.net Installation

> Click Install to start the installation.
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2 The components are being installed. This may take several minutes.

Installing SYCON.net for netX
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs SYCOM.net for netX. This
may take several minutes.

Status:
Copying new files

InstaliShield

Mext =

Figure 117: SYCON.net Installation Status

8. Finish Installation.

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed SYCOM.net
for netX, Click Finish to exit the wizard,

Figure 118: Finish SYCON.net Installation

» Click Finish, to complete the installation.
> SYCON.net has been installed.

Note: To start SYCON.net, use the Windows key to change from the
desktop mode to the start screen of Windows 8. In the start screen, click
on the SYCON.net tile. If the tile is not displayed, right-click on an empty
space, then click on the All Apps button appearing in the lower part of
the start screen. A list featuring all available programs (Apps) opens. In
this list, SYCON.net is shown below SYCON.net System Configurator
and can be started by double-click.
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4.4 Uninstalling SYCON.net
4.4.1

Uninstalling SYCON.net under Windows XP

SYCON.net uninstall procedure.

Note: Files and folders added by the user will not be deleted by the

» Close all application programs.

> In the Start menu of Windows, choose Control Panel.

2 The Control Panel opens:

B Control Panel

File Edit Wiew Favorites Tools  Help

\_)Back -\_;J L@ /':)Search H__ Faolders v

Address [} Conkrol Panel

v|Go

_— Marme &
R"' Control Panel ES Q_‘pnccessibility COpkions

E Add Hardware
[3’ Switch ko Cabegory Wisw o Add or Remove Programs
4 Administr ative Toolks

‘b Automatic Updates
!! cif Setup

P it Test

< Date and Time

§~ Displary

Flash Player

() Folder Options

[ﬂ Fonks

& Game Cortrollers
"ﬁlndexerstellung
Edtrtelry ama Driver
anternet Cphions

@ Kevboard

) Mouse

t_}, Mebwark Connections
LPhone and Madem Cptions
N

See Also

% 'windows Update
(7)) Help and Suppott

Camrments

Adjust vour computer settings ...
Installs and troubleshoaots har..,
h Install or remove programs an. ..
Configure adminiskrative settin, ..
Set up Windows to automatical, ..

Setup cif¥ Boards and channels

Test your cif¥ Boards and Cha...
Set the date, time, and time z...
Change the appearance of yo...

Manage Flash Plaver Settings

Customize the display of files a. ..
add, change, and manage fon...
Add, remowe, and configure g...
Microsoft Office Find Fast {tm)...
Steuern Sie die Grafikhardwar..,
Configure wour Inkernet displa...
Customize your keyvboard setti. .
iZuskamize your mouse setkting, ..
Connects ko other computers, L.,
Configure your telephone diali,. .

|

Figure 119: Control Panel

» Inthe Control Panel, double-click Add or Remove Programs.
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? The Add or Remove Programs window opens:

¥ Add or Remove Programs |-_||E|rz|
=3 )
@i Currently installed programs: [ showupdates Sork by:
Change or ks - b
Remaove ) —
Progroms i3 Size  6.60ME
i Size  10.20MB
% @ Size  27.75MB
Add Dews e Size  335.00ME
Programs
i . Size  2.16MB
. Entries from other programs
Ej L=l Size  1.60MB
Add/Remove ﬁ! Size 0.20MB
Windows
Components ,ﬁ Size  10.31MB
i Size  10.13MB
@ {3 Sie  3.E0ME
Set Prograrm .
Access and ﬂ Size 0.16MB
Defaults -
ol
rom your computer, click Change or Remave,
m Size 0.55ME v

Figure 120: Add or Remove Programs

» Select SYCON.net for netX entry.

» Click Remove.
2 A confirmation request appears:

Add or Remove Programs

\‘:’) Are woll suUre Yol want ko remove SYCOMN, net For nety from wour computer?

Figure 121: Confirmation Dialog

> Click Yes.

2 SYCON.net is being uninstalled from your host system or PC.
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Uninstalling SYCON.net under Windows 7

Note: Files and folders added by the user will not be deleted by the
SYCON.net uninstall procedure.

» Close all application programs.

System and Security
Review your computer's status
Back up your computer

Find and fix problems

Network and Internet
View network status and tasks
Choose homegroup and sharing options

Hardware and Sound
View devices and printers
Add a device

-

Programs
Uninstall a program

o
i

Get programs

8,
¥

> In the Start menu of Windows 7, select Control Panel.
? The Adjust your computer’s settings window opens:
[E=S[ECh ==
Q@v|@ » Control Panel » A4 |i’u‘p| |Search Contral Panel 0 |
Adjust your computer's settings View by: Category ~

User Accounts
'?g' Change account type

Appearance and
Personalization
Change the theme

Change desktop background
Adjust screen resolution

Clock, Language, and Region
Change keyboards or other input
methods

Change display language

Ease of Access
Let Windows suggest settings
Optimize visual display

Figure 122: Adjust Your Computer’s Settings Window

>

In the Programs group, click Uninstall a program.
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> The Uninstall or change a program window opens:

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

'@J Turn Windows features on or
el Organize *  Uninstall Change  Repair 3= - @
Install a program from the =

network Mame Publisher Installed On
- 10/11/2011
= 22/08/2011
£ 23/09/2011
e 25/08/2011
K Entries from other programs 25/08/2011
03 23/09/2011
CE| 23/09/2011
@ 23/09/2011
[ SYCON.net for netx ———Lfilaslean e bH 29/11/2011
= ninstall 23/00/2011
Change
Repair
4 | i b
= Hilscher GmbH Product version: 1.350.111128.7016
DT Help link: http://www.hilscher.com

Figure 123: Uninstall or Change a Program Window

» Right-click on the SYCON.net for netX entry and choose Uninstall
from the context menu.

2 A confirmation request appears:

Programs and Features

I Are you sure you want to uninstall 5YCOM.net for netX?

[] Inthe future, do not show me this dialog box

Figure 124: Confirmation Dialog

» Click Yes.
2 SYCON.net is being uninstalled from your host system or PC.
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4.4.3 Uninstalling SYCON.net under Windows 8

_) Note: Files and folders added by the user will not be deleted by the
SYCON.net uninstall procedure.

» In the Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 125: All Apps Button

» Click All apps.

> A list featuring all available programs (Apps) appears:

Apps

7-Zip File Manager

;| 7-Zip Help

Digitale Signatur
© far VBA-Projekte

icrosoft Clip

Microsoft Office
2003...

Microsoft Office
Anwendungswied...

=) Microsoft Office
Document Imaging

., | Microsoft Office
" Document...

Microsoft Office
Excel 2003

D Microsoft Office
B8 Outiook 2003

® & @

Unpin from Start  Pin to taskbar Uninstall

Microsoft Office
Picture Manager

Microsoft Office

PowerPoint 2003

Word 2003

Notepad++

Ethernet Device
Setup

SYCON.net v

Calculator
Character Map
Math Input Panel

Notepad

®@ ®

Open new Run as
window administrator

Figure 126: List of Installed Apps in Windows 8

Remote Desktop

Connection

Snipping Tool

Sound Recorder

Steps Recorder

Sticky Notes

Windows Fax and

Scan

Windows Journal

Windows Media

Player

WordPad

XPS Viewer

Magnifier

> Inthe Apps list, right-click the SYCON.net entry.
2> The context menu opens in the lower part of the screen.
» In the context menu, click Uninstall.

*

A
E
®

Narrator

Windows

Recognition

Command Prompt

Computer

Control Panel

Default Programs

H File Explorer
® Help and Support

Y

Run
Task Manager

Windows Defender
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2 Windows 8 changes into “desktop mode” and opens the Programs and
Features window:

1[5 « Programs » Programs and Features v & Search Programs and Features 0

Control Panel Home

Uninstall or change a program

View installed updates To uninstall a pregram, select it fram the list and then click Uninstall, Change, or

@' Turn Windows features on or Repair.
off

Install a program from the Organize ¥ Change  Repair = - @

network -
MName

Entries from other programs

= Hilscher GmbH Product version:  1.360.130301.9338
Help link:  http://www.hilscher.com

Figure 127: Uninstall or Change a Program Window

» Select SYCON.net for netX entry.
> Above the list, click Uninstall.
2 A security question appears:

i Are you sure you want to uninstall SYCOMN.net for netk?

[] Inthe future, do not show me this dialog box | Yes

Figure 128: Acknowledge Uninstall

> Click Yes.
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2 If the ODM Tray (which is a feature of the SYCON.net installation) is
still active, the following window opens:

The following applications should be closed before continuing the
installation:

CODMTray exe

® Automatically close applications and attempt to restart them after
setup is complete.

() Do neot close applications. (A Reboot may be required )

ok | Cancel |

Figure 129: Close ODMTray Dialog

» Choose Automatically close applications and attempt to restart
them after setup is complete option, then click OK.

» SYCON.net is being uninstalled from your host system or PC.
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5 netX Configuration Tool
5.1 Overview

With the netX Configuration Tool, you can configure or diagnose your
communication module. You can also use it to download or update the
firmware of your module. Note, however, that the tool can be used only for
slave devices, for master devices you have to use SYCON.net.

If the host system of your communication module runs under a Windows
operating system, you can install the netX Configuration Tool on your host
system for the above mentioned purposes. You can also install the tool on
a separate configuration PC under Windows, and then connect your
communication module via PCI Carrier Board (comX), Evaluation Board
(netJACK), USB or serial interface to the configuration PC and the netX
Configuration Tool.

The netX Configuration Tool is delivered on the Communication Solutions
DVD. You can start the installation program for the tool (the netX
Configuration Tool Setup Wizard) in the menu of the start screen of the
DVD. Instructions for this are provided on the following pages. You can also
start the installation program by double-clicking the
netXConfigurationUtility Setup.exe file in the Software\Slave
Configuration Tool directory of the Communication Solutions DVD.
The setup program contains all components needed for the installation
under Windows XP, Windows Vista, Windows 7 and Windows 8.

Please note the following:

¢ If the netX Configuration Tool shall access the communication module
via host interface or PC bus, you need to install the cifX Device Driver on
your host system or configuration PC. See chapter cifX Device Driver on
page 9.

¢ If the netX Configuration Tool shall access the communication module
via USB, you need to install the USB Driver on your host system or
configuration PC. See chapter USB Driver on page 42.

¢ You need administrator rights for installing or uninstalling the netX
Configuration Tool on your operating system.

¢ |f an older version of the netX Configuration Tool is already installed on
your system, uninstall it first before you install the new version.

¢ A description of the user interface of the netX Configuration Tool and
information on how to use this tool to configure or diagnose slave
devices is provided in the operating instruction manual
netX Configuration Tool for cifX, comX and netJACK — Configuration of
Real Time Ethernet and Fieldbus Devices, DOC1102050IxxEN, stored
on the Communication Solutions DVD.
The netX Configuration Tool is equipped with an online help, which can
be started by clicking the Help button or pressing the F1 key.
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5.2 Installing netX Configuration Tool
5.2.1 Installing netX Configuration Tool under Windows XP

1. Start the netX Configuration Tool installation program.

» Close all application programs and insert the Communication Solutions
DVD into the local DVD-ROM drive.

2 The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide
Install SYCOMN. net Configuration Saftware
Daocumentation
Dirivers, Software and Tools
Install cif / netJACK Device Driver
Install USBE Driver
Diriver Taalkit for Develaper
Install Slave Canfiguration Sofhware
Auxiliary Tools

A\ Moo (Clink s s> o > o
CHEEND .. ul = i 'L ’-l )
POWERLINK 1Modbus i%%%g Shoge sercos B hilsghear

the sutoemation bus e COMPETENCE IN

. COMMUNICATION

Figure 130: Start Screen Communication Solutions — Install netX Configuration Tool

> In the menu, choose Drivers, Software and Tools > Install Slave
Configuration Software.

Note: As an alternative, you can also start the installation program (i. e.
the netX Configuration Tool Setup Wizard) by double-clicking the
netXConfigurationUtility_Setup.exe file in the Software\Slave
Configuration Tool directory onthe Communication Solutions DVD.
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2 The netX Configuration Tool Setup Wizard is started:

i# netX Configuration Tool V1.x

Welcome to the netX Configuration Tool V1.x —
Setup Wizard ﬁ

chen
EOMPETENGE N
O e ML A TION

The installer will guide wou through the steps required to install net« Configuration Toolv1.x an
wOUr COmputer.

WARMNING: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may resultin severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Cancel

Figure 131: netX Configuration Tool Setup Wizard

» Click Next.

2. Choose Installation options.
> The Select Installation Folder window is displayed:

i# netX Configuration Tool ¥1.X

chen
EEMPETENGE N
00 e WL A TRON

Select Installation Folder ol
Al

The installerwill install net< Configuration Toalv1.x  tothe following folder.

Toinstall in this folder, click "Mext". To install to a different folder, enter it below or click "Broawse".

Folder:
CAProgrammeiHilscher GrbHnet< Configuration Toal %1% 4 [ Browse... l

[ Disk Cost.. ]

Ingtall netx Configuration ToalV1.x  foryourself, ar for anyone who uses this computer:

@Everyone

O Justme

Cancel l ’ < Back l | Mlext »

Figure 132: netX Configuration Tool Setup Wizard — Installation Options
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» If you accept the suggested standard installation directory, click Next. If
you prefer a different directory, enter the path directly in the Folder field
or click Browse to open the Browse for Folder dialog, in which you
can select a different directory.

» If you want to check which drive provides the required space for the
installation, click Disk Cost...

» If you want to restrict access to the netX Configuration Tool to your
login, click Just me option.

> Click Next.

3. Start the installation.
2 The Confirm Installation window is displayed:

i# netX Configuration Tool ¥1.X

Confirm Installation

The installer is ready to install net Configuration Toal%1.x onyour computer.

Click "Mext" to start the installation.

l Cancel ] l < Back ] | Mext >

Figure 133: netX Configuration Tool Setup Wizard — Confirm Installation

» Click Next to start the installation.
2 netX Configuration Tool is being installed.

i@ netX Configuration Tool V1.x

Installing netX Configuration Tool V1.x

net< Configuration Toal%1.x  is heing installed.

Flease wait...

Cancel

Figure 134: netX Configuration Tool Setup Wizard — Installation in Progress
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4. Finish installation.
> The Installation Complete window appears:

i# netX Configuration Tool V1.X

Installation Complete

net< Configuration Toal%1.x  has been successfully installed.

Click "Close" o exit,

Figure 135: netX Configuration Tool Setup Wizard — Installation Complete

» Click Close to finish the Installation.

2 netX Configuration Tool has been installed and can be started in the
Start menu of Windows via All Programs > Hilscher GmbH > netX
Configuration Tool.
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5.2.2 Installing netX Configuration Tool under Windows 7

1. Start the netX Configuration Tool installation program.

» Close all application programs and insert the Communication Solutions
DVD into the local DVD-ROM drive.

> The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide
Ingtall S¥CON.net Configuration Software
Documentation
Drivars, Software and Toals
Install cifs f netdaCk Device Driver
Install USB Driver
Drivar Toolkit for Developer
Install Slave Configuration Software
Auziliary Tools

@ CANcpen CC'Link
BowERCRK Whaoanus B0000°

. CORMMUNICATION

= -——-;_.-._3)

" sercos B2 hilsaha

Deviconer 2> EtherCAT~ gm0 oS> =—

the sutomation bus ey COMPETENCE IN

Figure 136: Start Screen Communication Solutions — Install netX Configuration Tool

» In the menu, choose Drivers, Software and Tools > Install Slave
Configuration Software.

Note: As an alternative, you can also start the installation program (i. e.
the netX Configuration Tool Setup Wizard) by double-clicking the
netXConfigurationUtility Setup.exe file in the Software\Slave
Configuration Tool directory onthe Communication Solutions DVD.
You can reduce the number of Windows security questions by right-
clicking on the netXConfigurationUtility _Setup.exe file and choosing Run
as administrator from the context menu.
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2 The netX Configuration Tool Setup Wizard is started:

" -
4 netX Configuration Tool V1.x EI_I—E_hJ

Welcome to the netX Configuration Tool ¥1 _x —
Setup Wizard %;ﬂ:ﬂ

The inztaller will guide pou thraugh the steps required to install net Configuration Tool V1% on
your computer,

WARMIMG: Thiz computer program is protected by copyright law and international treaties.
Unauthorized duplication or distibution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prozecuted to the maximum extent possible under the law.

Cancel < Back

Figure 137: netX Configuration Tool Setup Wizard

> Click Next.

2. Choose Installation options.
2 The Select Installation Folder window is displayed:

‘#2 netX Configuration Tool V1.x EI_IéJ

Select Installation Folder e
Al

Ty

ALY
COMPETENEE 1M
CORMUMICATION

The ingtaller will install nets Configuration Tool ¥1.%  to the following folder.

Toinstall in this folder, click "Mext". To install to a different folder. enter it below or click "Browse".

Folder:

C:%Program Files [#86)4Hilscher GmbHnet: Configuration Tool ¥1.x Browsze. ..
Dizk Cost...

Install net* Configuration Toal W1.%  for yourself, or for anyone who uses this computer:

@ Everyone

Just me

| Cancel | | < Back, | | et > |

b

Figure 138: netX Configuration Tool Setup Wizard — Installation Options

» If you accept the suggested standard installation directory, click Next. If
you prefer a different directory, enter the path directly in the Folder field
or click Browse to open the Browse for Folder dialog, in which you
can select a different directory.
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» If you want to check which drive provides the required space for the
installation, click Disk Cost...

» If you want to restrict access to the netX Configuration Tool to your
login, click Just me option.

> Click Next.

3. Start the installation.
2 The Confirm Installation window is displayed:

ﬁ netX Configuration Tool V1.x l — e
Confirm Installation —
hilscher
COMPETENCE N
SO R MUNICATION

The installer is ready toinstall net= Configuration Tool¥1.% on wour camputer,

Click "MNext" to start the installation.

[ Cancel l [ < Back ] [ Mew> |

b

Figure 139: netX Configuration Tool Setup Wizard — Confirm Installation

» Click Next to start the installation.
2 netX Configuration Tool is being installed.

'ﬁ netX Configuration Tool V1.x

Installing netX Configuration Tool
V1.x

nets Configuration Toal V1.3 is being installed.

Pleaze wait...

< Back Mext >

Figure 140: netX Configuration Tool Setup Wizard — Installation in Progress
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4. Finish installation.

> The Installation Complete window appears:

-
'ﬁ net¥ Configuration Tool V1.x

Installation Complete

Click "Cloze" to axit.

net Configuration Toal %1% has been successfully installed.

Cancel

< Back

Cloze

b

Figure 141: netX Configuration Tool Setup Wizard — Installation Complete

> Click Close to finish the Installation.

2 netX Configuration Tool has been installed and can be started in the
Start menu of Windows via All Programs > Hilscher GmbH > netX

Configuration Tool.
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5.2.3 Installing netX Configuration Tool under Windows 8

1. Start the netX Configuration Tool installation program.

» Close all application programs and insert the Communication Solutions
DVD into the local DVD-ROM drive.

> The start screen of the Communication Solutions DVD is displayed:

Communication Solutions

Installation Guide
Ingtall S¥CON.net Configuration Software
Documentation
Drivars, Software and Toals
Install cifs f netdaCk Device Driver
Install USB Driver
Drivar Toolkit for Developer
Install Slave Configuration Software
Auziliary Tools

@ CANcpen CC'Link
BowERCRK Whaoanus B0000°

. CORMMUNICATION

= -——-;_.-._3)

" sercos B2 hilsaha

Deviconer 2> EtherCAT~ gm0 oS> =—

the sutomation bus ey COMPETENCE IN

Figure 142: Start Screen Communication Solutions — Install netX Configuration Tool

» In the menu, choose Drivers, Software and Tools > Install Slave
Configuration Software.

Note: As an alternative, you can also start the installation program (i. e.
the netX Configuration Tool Setup Wizard) by double-clicking the
netXConfigurationUtility Setup.exe file in the Software\Slave
Configuration Tool directory onthe Communication Solutions DVD.
You can reduce the number of Windows security questions by right-
clicking on the netXConfigurationUtility _Setup.exe file and choosing Run
as administrator from the context menu.
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2 The netX Configuration Tool Setup Wizard is started:

Welcome to the netX Configuration Tool V1.«
Setup Wizard Chen

The installer will guide pou through the steps required to install net Configuration Tool V1.2 on
your computer.

WARMIMG: Thiz computer program is protected by copuright law and international treaties.
Unauthorized duplication or distibution of this program, ar any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law,

Figure 143: netX Configuration Tool Setup Wizard
» Click Next.

2. Choose Installation options.
2 The Select Installation Folder window is displayed:

Select Installation Folder

The ingtaller will install nets Configuration Tool %1.4 to the following folder.

Toinstall in this folder, click "Mext". To install to a different folder, enter it below or click "Browse".

Folder:
C:\Prograrn Files (#BE]%Hilzcher GmbHYwnet: Configuration Toal W1.06

Install net Configuration Tool %1.» for yourself, or for amyone who uses this computer:

(®) Everpone
() Just me

| Cancel | |

Figure 144: netX Configuration Tool Setup Wizard — Installation Options

» If you accept the suggested standard installation directory, click Next. If
you prefer a different directory, enter the path directly in the Folder field
or click Browse to open the Browse for Folder dialog, in which you
can select a different directory.
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» If you want to check which drive provides the required space for the
installation, click Disk Cost...

» If you want to restrict access to the netX Configuration Tool to your
login, click Just me option.

> Click Next.

3. Start the installation.
2 The Confirm Installation window is displayed:

Confirm Installation ﬂg

The installer is ready toinstall net: Configuration Tool %¥1.4 on your computer,

Click "Mext" to start the installation.

| Cancel | | < Back | | Hewt> |

Figure 145: netX Configuration Tool Setup Wizard — Confirm Installation

> Click Next, to start the installation.
2 netX Configuration Tool is being installed.

Installing netX Configuration Tool ﬁé
V1o E

net Configuration Tool Y1 1 is being installed.

Please wait...

Figure 146: netX Configuration Tool Setup Wizard — Installation in Progress
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4. Finish installation.
> The Installation Complete window appears:

i netX Configuration Tool V1.x =

Installation Complete

net Configuration Tool V1.5 has been successfully installed.

Click "Close" to exit.

Cancel Back

Figure 147: netX Configuration Tool Setup Wizard — Installation Complete

> Click Close, to finish the Installation.
2 netX Configuration Tool has been installed.

Note: To start the netX Configuration Tool, use the Windows key to
change from the desktop mode to the start screen of Windows 8. In the
start screen, click on the netX Configuration Tool tile. If the tile is not
displayed, right-click on an empty space, then click on the All Apps
button appearing in the lower part of the start screen. A list featuring all
available programs (Apps) opens. In this list, netX Configuration Tool is
shown below Hilscher GmbH and can be started by double-click.
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5.3 Uninstalling netX Configuration Tool
5.3.1

» Close all application programs.

Uninstalling netX Configuration Tool under Windows XP

> In the Start menu of Windows, choose Control Panel.

2 The Control Panel opens:

B Control Panel =13

File Edit “iew Favorites Tools  Help

\_) Back. \_,J lﬁ p Search I{ = Falders -

Address |:} Cantral Pangl v| o
— MName -~ Comments )
R"' Control Panel -3 &Accessibility Cptions Adjust vour computer settings ...

& add Hardware Installs and troubleshoots har. ..

0 Add or Remaove Programs
48 Administrative Tools

ﬁ Automatic Updates
!-!cifx Setup

P ciF % Test

:5’Date and Tirme
a\Display

Flash Plaryer

| Folder Options

ﬁants

& Game Controllers
"ﬁlndexerstellung

B rteiiry GMa Driver
anternet Cipkions
mKeyboard

Ty Mause

e__;Network Connections
LF‘hnne and Modern Opkions
M

[3 Switch to Cateqgary Yiew

See Also

h windows Update
()] Help and Support

h Install or remowe programs an...

Configure administrative setkin, .
Set up Windows ko autormatical...

Setup cif¥ Boards and channels

Tesk your cif¥ Boards and Cha. ..
Set the date, time, and kime z...
“hange the appearance of vo...

Manage Flash Player Settings

Zustomize the display of files a...
#dd, change, and manage fon...
Add, remove, and configure g...
Microsoft Office Find Fask (tm)...
Steuern Sie die Grafikhardwar, .
Configure wour Internek displa. ..
Customize vour kevboard setti...
Custornize your mouse setking...
Zonnecks to other computers, ...
Caonfigure vour telephone diali...

Figure 148: Control Panel

» Inthe Control Panel, double-click Add or Remove Programs.

2 The Add or Remove Programs window opens:

% Add or Remove Programs

&

Currently installed programs: [ showupdates

e netx Configuration Tool ¥1.x

© -

Sek Prograrn
Access and

Defaulks
o]

uppork info

Tao change this program or remove it fro

YO Cormputer

Change or b 2
Remaove Cla ) —
Pragrams o3 Size 6.63ME
Size  10.20MB
%‘ i Size  27.75MB
Add New )
Flis @ Size  335.00MB
. Size  2.16MB
is Entries from other programs
- Size  1.69MB
AddjRemave | _ Size  0.20MB
‘windows =-]
Components Size 10.531MB

Size 0.55ME v

Figure 149: Add or Remove Programs
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» Select netX Configuration Tool entry.
» Click Remove.
2> A confirmation request appears:

\:!() Are vl sure waol want ko remove nek Configuration Taaol % .x Fram yaur computer?

Lotes J[ w |

Figure 150: Confirmation Dialog

> Click Yes.

2 netX Configuration Tool is being uninstalled from your host system or
PC.
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53.2 Uninstalling netX Configuration Tool under Windows 7
» Close all application programs.
> In the Start menu of Windows 7, select Control Panel.
> The Adjust your computer’s settings window opens:
(o] 8 /=]
O@v|@ » Control Panel » - | +y | | |Search Control Panel 2 |
Adjust your computer's settings View by: Category ~
|@| System and Security % User Accounts
" Review your computer's status ) )
13 Back up your computer ® Change sccount type
Find and fix problems _ Appearance and
Network and Internet %" Personalization
&I View network status and tasks Change the theme
“&2, Choosehomegroup and sharing options Change desktop background
Adjust screen reselution
, / Hardware and Sound i
View devices and printers Clock, Language' and Reglon
o Add a device | Change keyboards or other input
/ methods
[4____ Programs Change display language
Ia ‘,j gz:r:g;:;r:gmm 47 W Ease of Access
|.\J Let Windows suggest settings
Optimize visual display
|
Figure 151: Adjust Your Computer’s Settings Window
» Inthe Programs group, click Uninstall a program.
2 The Uninstall or change a program window opens:
( [l
—
@Uv|@ » Control I?a_rlel ’ Programs_b Programs and F_E_atures i Search Programs and Features pl
Saprol Panel el Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
'Ei,‘ Turn Windows features on or
ot Organize =  Uninstall Change  Repair 3= = @
Install a program from the =
network Mame Publisher Installed On
|- 10/11/2011
& 22/08/2011
5 23/09/2011
i 25/08/2011
<] Entfias:f th 25/08/2011
0 ntries rom otner programs 23/09/2011
0 23/09/2011
@ . - 23/09/2011
|2 InetX Configuration Teel V1.x e L0
Ba Uninstall 29/11/2011
== Change 23/09,2011
Repair
A 1 2
‘ "!- Hilscher GmbH Product version: 1.05.03
. Help link: www.hilscher.com

Figure 152: Uninstall or Change a Program
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» Right-click on the netX Configuration Tool entry and choose Uninstall
from the context menu.

2 A confirmation request appears:

Programs and Features

! . Areyou sure you want to uninstall netX Configuration Tool VL. 7
i

[ 1Inthe future, do not show me this dialog box Yes ] [ No

Figure 153: Confirmation Dialog

> Click Yes.

2 netX Configuration Tool is being uninstalled from your host system or
PC.

Software Installation comX and netJACK | Installing Drivers and Configuration Software
DOC130405UMO1EN | Revision 1 | English | 2013-10 | Released | Public © Hilscher 2013



netX Configuration Tool

110/116

5.3.3

Uninstalling netX Configuration Tool under Windows 8

» In the Start screen of Windows 8, right-click on an empty space.
2 The All apps button appears in the lower part of the screen:

All apps

Figure 154: All Apps Button

» Click All apps.

2 A list featuring all available programs (Apps) appears:

Apps

Z Adobe Reader X
Bing
Erowser Choice
Calendar
Camera
Desktop
Finance
Games

Internet Explorer

Maps

Messaging

Neues Office-
Dokument

News 7-Zip File Manager

1<)

Office-Dokument
offnen

7-Zip Help

)

People

B

Photos J netX Configuratior¥

Tool

Reader Open Log Folder

H &

SkyDrive

Sports Digitale Signatur

fur VBA-Projekte

Microsoft Clip
Organizer

Microsoft Office
2003 Assistent zu...

Travel

Video Microsoft Office
2

Weather Microsoft Office

Anwendungswied...

Microsoft Office
Document Imaging

®

Unpin from Start

Pin to taskbar

Uninstall

®@ &

Open new
window

@

Open file

location

Run as
administrator

Microsoft Office
Document...

Microsoft Office
Excel 2003

Microsoft Office
Outlook 2003

Microsoft Office
Picture Manager

Microsoft Office
PowerPoint 2003

Microsoft Office
Word 2003

MNotepad++

Calculator
Character Map
Math Input Panel

Motepad

Figure 155: List of Installed Apps in Windows 8 — Uninstall netX Configuration Tool

» Inthe Apps list, right-click the netX Configuration Tool entry.
2> The context menu opens in the lower part of the screen.

> In the context menu, click Uninstall.
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2 Windows 8 changes into “desktop mode” and opens the Programs and
Features window:

T[54 « Programs » Programs and Features v & Search Programs and Features @

Control Panel Home

Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or

@' Turn Windows features on or Repair.
off

Install a program frem the Organize v Change  Repair

network -
MName

Entries from other programs

Cia
oa

| [5 netX Configuration Tool

CE|

£
I Hilscher GmbH Product version:  1.06.00
. Help link:  www.hilscher.com

Figure 156: Programs and Features Window

» Select netX Configuration Tool entry.
» Above the list, click Uninstall.
2 A security question appears:

i Are you sure you want to uninstall net¥ Configuration Tool V1. %

[] Inthe future, do not show me this dialog box

Figure 157: Acknowledge Uninstall

» Click Yes.
» netX Configuration Tool is being uninstalled from your host system or
PC.
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6.3 Contacts

Headquarters

Germany

Hilscher Gesellschaft fir
Systemautomation mbH
Rheinstrasse 15

65795 Hattersheim

Phone: +49 (0) 6190 9907-0
Fax: +49 (0) 6190 9907-50
E-Mail: info@hilscher.com

Support
Phone: +49 (0) 6190 9907-99
E-Mail: de.support@hilscher.com

Subsidiaries

China

Hilscher Systemautomation (Shanghai) Co. Ltd.

200010 Shanghai
Phone: +86 (0) 21-6355-5161
E-Mail: info@bhilscher.cn

Support
Phone: +86 (0) 21-6355-5161
E-Mail: cn.support@hilscher.com

France

Hilscher France S.a.r.l.

69500 Bron

Phone: +33 (0) 4 72 37 98 40
E-Mail: info@hilscher.fr
Support

Phone: +33 (0) 4 72 37 98 40
E-Mail: fr.support@hilscher.com

India

Hilscher India Pvt. Ltd.
New Delhi - 110 065
Phone: +91 11 43055431

E-Mail: info@hilscher.in

Italy

Hilscher Italia S.r.l.

20090 Vimodrone (Ml)

Phone: +39 02 25007068
E-Mail: info@hilscher.it
Support

Phone: +39 02 25007068
E-Mail: it.support@hilscher.com

Japan

Hilscher Japan KK

Tokyo, 160-0022

Phone: +81 (0) 3-5362-0521
E-Mail: info@hilscher.jp
Support

Phone: +81 (0) 3-5362-0521
E-Mail: jp.support@hilscher.com

Korea

Hilscher Korea Inc.

Suwon, Gyeonggi, 443-734
Phone: +82 (0) 31-695-5515
E-Mail: info@hilscher.kr

Switzerland

Hilscher Swiss GmbH

4500 Solothurn

Phone: +41 (0) 32 623 6633
E-Mail: info@hilscher.ch

Support
Phone: +49 (0) 6190 9907-99
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